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Preface

Purpose of This Manual
This manual describes how to operate the system software for spectroscopic measurements/analyses
and imaging measurements/analyses using the TAS7x00 Series Terahertz Spectroscopy & Imaging
System.

Related Manuals
TAS7500 Series Terahertz Spectroscopy & Imaging System Instruction Manual

This manual describes the procedures required to perform measurement and analysis operations
including handling notes for safe use, after the system is installed.

TAS7400 Series Terahertz Spectroscopy System Instruction Manual
This manual describes the procedures required to perform measurement and analysis operations
including handling notes for safe use, after the TAS7400 system is installed.

TAS7x00 Series Terahertz Spectroscopy & Imaging System System Software Operation
Manual (Quantitative Analysis Option)

This manual describes how to add the license for the optional quantitative analysis function to
system software, operation method, and function itself.
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1. Overview

This system is a nondestructive spectroscopy & imaging analysis system that utilizes terahertz
(THz) waves. Spectrum analysis and tablet imaging analysis can be performed. Use the spectro-
scopic unit for spectrum analysis. Use the imaging unit for tablet imaging analysis.
This manual describes how to operate the software when using the spectroscopic and imaging units.

The TAS7400 system performs spectrum analysis. Therefore, an imaging unit is not included. For
the TAS7400 system, there are not any imaging unit related operations in this manual.

 For more information on the configuration of software, refer to 12. "Software
Specifications" on page 12-1.

 For more information on the coating quality analysis option, refer to 9. "Coating Quality Anal-
ysis Option" on page 9-1.

 For more information on the polarization analysis option, refer to 10. "Polarization Analysis
Option" on page 10-1.
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2. System Start Up and Shut Down

This chapter describes how to start up and shut down the system.

2. 1 System Start Up
The system start procedure is as follows. It is assumed that the circuit breaker on the back of the
measurement unit and the one on the back of the analysis frame are ON beforehand.

Important
 Before starting system software, warm up the system at least one hour after its power is turned

on.
 

1) Switch the key switch on the front panel of the measurement unit to ON.

2) Turn on the system controller.

3) Double click the TAS7x00 icon on the desktop.
The Navigation window opens.

Figure 2-1 TAS7x00 Icon

Figure 2-2 Navigation Window
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2. 2 System Shut Down
The system shutdown procedure is as follows:

1) Click the [EXIT] button in the Navigation window to exit the software.

2) Shut down the system controller.

Important
 Termination of the analysis unit firmware is executed during the shutdown procedure for the

system controller. If the firmware is not terminated properly, the system may not start
smoothly the next time it is started up. Therefore, wait until the system controller finishes the
shutdown processing before proceeding with the next procedure.

 

3) Switch the key switch on the front panel of the measurement unit to OFF.
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3. Navigation Window

This chapter describes the Navigation window.

3. 1 Window Layout
The Navigation window is the first window that appears when the system software starts.

Figure 3-1 shows the user interfaces in the Navigation window.

Figure 3-1 Navigation Window
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3. 2 Menu Bar
The menu bar contains the following items:

[Version]
The [Version] menu displays version information.
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3. 3 Tool Bar
The tool bar contains the following buttons:

The buttons on the unit are enabled only when it is connected. Also, hardware is initialized at the
first startup.

Opens measurement window for spectroscopic unit.

Opens measurement window for spectroscopic unit (Low-Frequency Coverage).

Opens measurement window for spectroscopic unit (Wide-Band Coverage).

Opens measurement window for imaging unit.

Opens PQ/OQ window.

Opens Analyze window.

Exits software.
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4. Spectroscopic Unit

This chapter describes the spectroscopic unit.

4. 1 Operating Procedure
This section describes the operation procedures using the spectroscopic unit.

4. 1. 1 Basic Measurement Operations

Basic operations of the measurement function are roughly categorized into the following four steps:

1. Starting the Spectroscopic Measurement window

2. Performing background measurement

3. Performing sample measurement

4. Saving sample waveforms to a file

The following section describes the measurement operations.

Reflection measurement is used as an example for descriptive purposes.

1) Start the Spectroscopic Measurement window.
Click the [Spectroscopy] button in the Navigation window to start the Spectroscopic Measure-
ment window.

Figure 4-1 Spectroscopy Button

When the Measurement window opens, execute [Measurement]  [Check Measurement
Module] from the menu bar to detect the current measurement module.
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Figure 4-2 Spectroscopic Measurement Window

2) Place a mirror on the measurement module to perform background measurement.

Figure 4-3 Setting Mirror

3) Select the General tab in the condition setting area of the Spectroscopic Measurement window
and specify the settings as shown in the following figure:



4–3

4. 1 Operating Procedure

6/2/14

Figure 4-4 General Tab in Condition Setting Area

4) Select the Condition tab in the condition setting area of the Spectroscopic Measurement window
and specify the conditions as shown in the following figure:
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Figure 4-5 Condition Tab in Condition Setting Area

5) Execute background measurement.
Click the background measurement button on the tool bar to display the background waveform.
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Figure 4-6 Background Measurement

6) Place the sample on the measurement module.

Figure 4-7 Setting Sample

7) Execute sample measurement.
Click the sample measurement button on the tool bar to display the sample waveform.
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Figure 4-8 Sample Measurement

To continuously acquire and monitor the sample waveform, click the  button on the tool bar.
To stop this operation, click the  button.

8) Save the sample waveform to a file.
Click the  button on the tool bar to open a file selection dialog box. Enter a file name in the
dialog box and save the file.
To analyze data immediately after measurement, transfer the sample waveform to the Analyze
window using the  button on the tool bar.

4. 1. 2 Basic Analysis Operations

Basic operations of the analysis function are roughly categorized into the following three steps:

1. Starting the Analyze window

2. Loading the waveform data file

3. Analyzing waveforms. In this section, the following operations are performed as examples:

• Changing the vertical axis

• Smoothing

• Detecting peaks

• Comparing two waveforms
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The following section describes analysis operations:

1) Start the Analyze window.
Click the [Analysis] button in the Navigation window to start the Analyze window.

Figure 4-9 Analysis Button

Figure 4-10 Analyze Window

2) Load a data file.
Select [File]  [Load PointData...] in the Analyze window to start a file selection dialog box.
Enter the file name in the dialog box and load the file. A graph window then opens and the spec-
trum is displayed.
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Figure 4-11 Graph Window

3) Change the type of vertical axis for the spectrum.
For example, click [Vertical Axis]  [Reflectance(Log) [dB]] in the graph window to
change the type to reflectance. A new graph window then opens and the reflectance is displayed.

Figure 4-12 Graph Window Displaying Reflectance
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4) Execute smoothing to remove noise from the spectrum.
Click [Calculation] [Smoothing] in the graph window to start the Smoothing dialog box.
For example, specify the conditions as shown in the following figure and click the [Execute]
button to execute Savitzky-Golay smoothing. The result is then displayed in the lower graph.
Repeat this work while changing conditions and check the result.

Figure 4-13 Smoothing Dialog Box

When an appropriate result is achieved, click the [OK] button. The smoothed spectrum is then
displayed in the new graph window of the Analyze window.
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Figure 4-14 Graph Window after Smoothing

5) Detect peaks.
Click [Analysis]  [Peak Detection] in the graph window to start the Peak Detection dialog
box. For example, enter the settings as shown in the following figure and click the [Execute]
button to detect only the positive peaks with levels greater than -22.
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Figure 4-15 Peak Detection Dialog Box

Clicking the [OK] button at this point displays labels (horizontal axis values) at the positions of
the relevant peaks in the graph window.

Figure 4-16 Displaying Labels (Positions on Horizontal Axis)

6) Load another data file and overlap spectra for comparison.
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In the following example, another data file has been loaded according to step 2) and two graph
windows have started.

Figure 4-17 Two Waveforms

Select Sample2 with the mouse and press the [Ctrl and C] keys. Display the Sample1 window in
front and press the [Ctrl and V] keys. The spectra in Sample1 and Sample2 then overlap.

Figure 4-18 Graph Window where Two Waveforms Overlap
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4. 1. 3 Polarization Measurement and Analysis Operations 
(Polarization Analysis Option)

The following describes the polarization measurement and analysis operation procedure:

1) Background measurement
The procedure for measuring the background is as follows.

1. Remove the sample from the transmission module (polarization measurement type).

2. Input the measurement parameters in the parameter settings area.

3. Click the Background Measurement button on the tool bar.

4. This will bring up a message box containing the following instructions.
"Set the wire grid angle lever  to 0 degrees, and  push OK button."

5. Following the instruction, set the angle adjustment lever of the wire grid of the transmission
module (polarization measurement type) to 0 and click the [OK] button.

1) Background measurement Measure the background. The wire grid angle is 0.



2) Sample measurement Measure the sample. The wire grid angles are 45 and -45.



3) Measurement data analysis Analyze measurement data.
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Figure 4-19 Background Measurement

2) Sample measurement
The procedure for sample measurement is as follows. In the polarization settings, the angle of the
wire grid can be set in one of two positions (45 and -45).

1. Place the sample in the transmission module (polarization measurement type).

2. Click the Polarization Measurement button on the tool bar.

3. This brings up a message box containing the following instructions.
"Set the wire grid angle lever  to 45 degrees, and  push OK button."

4. Following the instruction, set the angle adjustment lever of the wire grid of the transmission
module (polarization measurement type) to 45 and click the [OK] button.

5. This brings up a message box containing the following instructions.
"Set the wire grid angle lever  to -45 degrees, and  push OK button."

6. Following the instruction, set the angle adjustment lever of the wire grid of the transmission
module (polarization measurement type) to -45 and click the [OK] button.

7. Click the File Save button to save the measurement data.

8. In order to analyze the measurement data, transfer the measurement data to the analysis win-
dow by clicking the data transfer button.
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Figure 4-20 Sample Measurement

3) Measurement data analysis
The polarization analysis data transferred from the measurement window is shown in a single
graph window containing the overlapping waveforms for 45 and -45.

Figure 4-21 Transferred Polarization Analysis Data
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In the analysis window, the polarization analysis data can be displayed using various axes. The
desired axes can be selected from the Polarization menu in the graph window.
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Figure 4-22 Displaying the Polarization Analysis Data along Various Axes



4–18

4. Spectroscopic Unit

6/2/14



4–19

4. 2 Spectroscopic Measurement Window

6/2/14

4. 2 Spectroscopic Measurement Window
This section describes the Spectroscopic Measurement window.

4. 2. 1 Window Layout

Figure 4-23 shows the user interfaces in the Spectroscopic Measurement window.

Figure 4-23 Spectroscopic Measurement Window

4. 2. 2 Menu Bar

The menu bar contains various pull-down menus for measurement.

4. 2. 2. 1 [File]

The following selections can be made in the [File] menu:

 [File]  [Save Data...]

This command saves sample waveforms to a file.
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Sample waveforms can be saved in the following file formats:

 [File]  [Print Report...]

This command prints a report.

Clicking this command opens the Print Report dialog box.

 For more information on this dialog box, refer to 4. 2. 5. 6 "Print Report Dialog Box" on
page 4-37.

 [File]  [Close]

This command closes the Spectroscopic Measurement window.

4. 2. 2. 2 [Measurement]

The following selections can be made in the [Measurement] menu:

 [Measurement]  [Single Measurement]

This command executes sample measurement (once).

 [Measurement]  [Repeat Measurement]

This command repeats sample measurement.

Use this command to observe the temporal change of waveforms.

 [Measurement]  [Programmable Measurement]

This command repeats measurement at certain time intervals and saves measurement data to a file.

Clicking this command opens the Programmable Measurement dialog box.

 For more information on this dialog box, refer to 4. 2. 5. 1 "Programmable Measurement
Dialog Box" on page 4-27.

 [Measurement]  [Polarization Measurement]

This command executes a polarization measurement.

TAS7x00 PointData (*.pnt) Spectrum measurement data file

CSV (*.csv) CSV file

JCAMP-DX (*.jdx) JCAMP-DX format file
The JCAMP-DX format is the standard file format used to exchange spectroscopic 
data.

SPC (*.spc) SPC format file
The SPC format is a spectroscopic data file format developed by Galactic (current 
name: Thermo Scientific).
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 [Measurement]  [Background Measurement]

This command executes background measurement.

 [Measurement]  [Stop Measurement]

This command stops measurement.

 [Measurement]  [Abort Measurement]

This command terminates measurement.

Data during measurement is discarded.

 [Measurement]  [Send to Analysis]

This command transfers a sample waveform to the Analyze window.

 [Measurement]  [Check Measurement Module]

This command detects the currently connected measurement module. The detected measurement
module is displayed in Measurement Mode on the Condition tab.

 [Measurement]  [Dry Air Purge]

This command executes dry air purge.

 [Measurement]  [Adjust Laser]

This command executes laser correction.

This menu item is displayed only for the TAS7500 series.

 [Measurement]  [Auto-Adjustment of Laser]

This command sets periodically-executed laser automatic correction ON or OFF.

However, automatic correction is forced to be set ON when the imaging unit measurement window
or PQ/OQ window opens.

This menu item is displayed only for the TAS7500 series.

4. 2. 2. 3 [Options]

The following selections can be made in the [Options] menu:

 [Options]  [Visualization...]

This command specifies the waveform and background colors.
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Clicking this command opens the Visualization dialog box.

 For more information on this dialog box, refer to 4. 2. 5. 4 "Visualization Dialog Box" on
page 4-32.

 [Options]  [Environment...]

This command specifies where to save system data and the default scale.

Clicking this command opens the Environment dialog box.

 For more information on this dialog box, refer to 4. 2. 5. 5 "Environment Dialog Box" on
page 4-35.

 [Options]  [Report Settings..]

This command sets items output to a report.

Clicking this command opens the Report Settings dialog box.

 For more information on this dialog box, refer to 4. 2. 5. 7 "Report Settings Dialog Box" on
page 4-39.

4. 2. 2. 4 [Window]

The following selections can be made in the [Window] menu:

 [Window]  [Cascade]

This command cascades graph windows.

 [Window]  [Tile Horizontal]

This command horizontally tiles graph windows.

 [Window]  [Tile Vertical]

This command vertically tiles graph windows.
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4. 2. 3 Tool Bar

The tool bar contains the following buttons:

4. 2. 4 Condition Setting Area

This section describes the condition setting area.

Shortcut to [Measurement]  [Single Measurement]

Shortcut to [Measurement]  [Repeat Measurement]

Shortcut to [Measurement]  [Programmable Measurement]

Shortcut to [Measurement]  [Polarization Measurement]

Shortcut to [Measurement]  [Background Measurement]

Shortcut to [Measurement]  [Stop Measurement]
When this button is blue, repeated measurement is stopped.
When this button is red, single measurement is stopped.

Shortcut to [Measurement]  [Abort Measurement]

Shortcut to [Measurement]  [Send to Analysis]

Shortcut to [File]  [Save Data...]

Shortcut to [File]  [Print Report...]

Shortcut to [Measurement]  [Check Measurement Module]

Shortcut to [Measurement]  [Dry Air Purge]
During dry air purge execution, ON is displayed on button.

Shortcut to [Measurement]  [Adjust Laser]
This button is displayed only for the TAS7500 series.

Shortcut to [Measurement]  [Auto-Adjustment of Laser]
When laser automatic correction is OFF, a red diagonal line is displayed on the button.
This button is displayed only for the TAS7500 series.

Measurement condition Specifies the measurement name.

[Save...] button Saves measurement conditions to a file.

[Load...] button Loads a measurement condition file.



4–24

4. Spectroscopic Unit

6/2/14

4. 2. 4. 1 General Tab

This section describes the General tab.

Prefix Specifies a measurement data name.

[Naming Rules...] button Specifies the naming rules for measurement data.
Clicking this button opens the Naming Rules dialog box.

 For more information on this dialog box, refer to 4. 2. 5. 2 "Naming 
Rules Dialog Box" on page 4-28.

Comment Enter comment on measurement data.

[Enable auto transfer to analysis] checkbox

When this button is ON, measurement data is automatically transferred to the 
Analyze window.

[Enable auto save] checkbox When this button is ON, measurement data is automatically saved to a file.

[Save displayed data CSV] checkbox

When this button is ON, measurement data is saved to a file in CSV format.

[Save TimeDomain CSV] checkbox

When this button is ON, time waveform data of measurement data is saved to a 
file in CSV format.
In this file, both sample waveform and background waveform data items are 
contained.

[Browse...] button Specifies where to save measurement data.

[Show Background message] checkbox

Usually, when measuring the background with the transmission module (polar-
ization measurement type), a confirmation message about the wire grid angle is 
displayed. The message is displayed if the checkbox is ticked and not displayed 
if the checkbox is not ticked.
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4. 2. 4. 2 Condition Tab

This section describes the Condition tab.

Measurement Mode Displays the installed measurement module.

Frequency Resolution Displays the frequency resolution.

The TAS7400 can select either of the following frequency resolutions:
1.9 GHz/7.6 GHz [Default: 1.9 GHz]

Vertical Axis Selects a type of vertical axis.

Transmittance(Log) [dB] Transmittance (log display)
This can only be selected in the transmission or polar-
ization measurement mode.

Transmittance(Linear) [%] Transmittance
This can only be selected in the transmission or polar-
ization measurement mode.

Reflectance(Log) [dB] Reflectance (log display)
This can only be selected in the reflection measurement 
mode.

Reflectance(Linear) [%] Reflectance
This can only be selected in the reflection measurement 
mode.

ATR(Log) [dB] ATR (log display)
This can only be selected in the ATR measurement 
mode.

ATR(Linear) [%] ATR
This can only be selected in the ATR measurement 
mode.

Log(1/R) Log (1/R) is calculated as R=Io/I from the power spec-
trum (I) of the sample and the reference power spec-
trum (lo).
The same as Absorbance when the measurement mode 
is Transmission.

Absorbance Absorbance
This can only be selected in the transmission or polar-
ization measurement mode.

Absorption Coefficient [cm-1] Absorption coefficient

Extinction Coefficient Extinction coefficient 

Refractive Index Refractive index 

Permittivity Permittivity

Dielectric Loss Dielectric loss

Phase Shift [rad] Phase difference

Power(Log) [dB] Frequency spectrum (log display)

Power(Linear) Frequency spectrum

Phase [rad] Phase

Time Domain [V] Time waveform
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Horizontal Axis Selects a type of horizontal axis.

Frequency [THz] Frequency

Wave Numbers [cm-1] Number of waves

Wave Length [um] Wavelength

Time [psec] Time
This can only be selected when Time Domain [V] is 
selected as the vertical axis type.

Cumulated number (Sample)

Specifies how many times sample measurement is cumulated.
1 to 16384

Cumulated number (Background)

Specifies how many times background measurement is cumulated.
1 to 16384

[Parameter Settings...] button

Specifies detailed axis conversion conditions.
Clicking this button opens the Parameter Settings dialog box.

 For more information on this dialog box, refer to 4. 2. 5. 3 "Parameter Settings Dia-
log Box" on page 4-29.

Apply specific calculate list file

[Clear] button Clears the calculation list file.

 For more information on the calculation list file, refer to 7. 1 "Calculation List 
(File)" on page 7-1.

[Load...] button Loads the calculation list file.

 For more information on the calculation list file, refer to 7. 1 "Calculation List 
(File)" on page 7-1.

[Apply specific background file] checkbox

Turn ON this button to specify the background waveform with a file.

[Save ...] button Saves the background waveform to a file.

[Load ...] button Loads the background waveform from a file

Rotation angle Specifies the angle of the wire grid of the transmission module (polarization measurement 
type). The angle can be set to 0, 45 and -45. These values must match the actual position 
of the lever. Only active for Single and Repeat measurements with the transmission module 
(polarization measurement type).
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4. 2. 5 Dialog Boxes

This section describes dialog boxes.

4. 2. 5. 1 Programmable Measurement Dialog Box

This dialog box is used to repeat measurement at certain time intervals and save measurement data
to a file.

The following three file types are saved:

1. Spectrum measurement data file

2. CSV-format file containing time waveform data*1

3. CSV-format file containing currently displayed vertical axis data

*1 As for 2., time waveform data of sample and background waveforms is output to a file.
However, if sample waveforms does not have a background waveform, this data is not displayed.

Start this dialog box by selecting [Measurement]  [Programmable Measurement].
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Figure 4-24 Programmable Measurement Dialog Box

4. 2. 5. 2 Naming Rules Dialog Box

This dialog box is used to specify the naming rules for measurement data.

The number or date can be selected in this dialog box.

Start this dialog box by clicking the [Naming Rules...] button described in 4. 2. 4. 1 "General
Tab" on page 4-24.

Prefix Specify a prefix to be attached to the saved file name.

Tip
 The settings in the Naming Rules dialog box are applied for the name of file to be saved.

 For more information on the dialog box, refer to 4. 2. 5. 2 "Naming Rules Dialog Box" on page 4-28.
 

Save path

[Browse...] button Specifies the directory in which to save the file.

Time step Specifies a time interval. The unit is seconds. (0 to 20000)

Count Specifies the number of times measurement is executed. (1 to 2000)

[Start] button Starts timer measurement.

[Stop] button Stops measurement.

[Abort] button Terminates measurement.

[Close] button Closes the dialog box.
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Figure 4-25 Naming Rules Dialog Box

4. 2. 5. 3 Parameter Settings Dialog Box

This dialog box is used to specify detailed axis conversion conditions.

Start this dialog box by clicking the [Parameter settings...] button described in 4. 2. 4.
2 "Condition Tab" on page 4-25 or the [Parameter settings...] menu described in 4. 5.
4 "Pop-up Menu" on page 4-76.

[Append number] button Turn this button ON to select a number.

Current number Initial number (0 to 9999)
If 0 is specified, a number is not appended. When measurement is executed from 
the Programmable Measurement dialog box, this value is initialized to 0.

Number of digits Number of digits (1 to 4)

[Always append number] checkbox

When selected, sequential numbers are given to file names even when Current-
Number is 0.

[Append time stamp] button

Turn this button ON to select the date.
The format is yyyymmddhhmmss.

[OK] button Enables the specified setting.

[Cancel] button Closes the dialog box.
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Figure 4-26 Parameter Settings Dialog Box

 Apodization

Displays window function conditions.

 FFT calculation settings

Specifies the conditions under which fast Fourier transform (FFT) is executed for the time domain
waveform.

Tip
 If background waveform data does not exist, its related items are not displayed.
 

Enable Whether to apply the window function.

Window order Order of window function.

md (amplitude of both edges) Amplitude of both edges.

div (peak position) Peak data position.

Start time (Sample) [psec] Start position of effective data when FFT is executed for sample waveforms. 
(0.000 to Stop time)

Stop time (Sample) [psec] Stop position of effective data when FFT is executed for sample waveforms. 
(Start time to 528.000)

Start time (Background) [psec] Start position of effective data when FFT is executed for background waveforms. 
(0.000 to Stop time)

Stop time (Background) [psec] Stop position of effective data when FFT is executed for background waveforms. 
(Start time to 528.000)
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 Valid data range

Displays data range conditions.

 Phase unwrap settings

Specifies the conditions for phase unwrap processing.

 For more information on phase unwrap processing, refer to 7. 2 "Phase Unwrap
Processing" on page 7-2.

 Absolute phase shift prediction settings

Displays phase difference conditions.

 Refractive index calculation condition

Specifies the refractive index calculation conditions.

 Sample Thickness[mm]

Sample thickness. (0.00001 to 10.00000)

 Number of Multiple Reflection

Specifies the number of multiple reflections. (0 to 50)

 [OK] button

Enables the specified parameters.

 [Cancel] button

Closes the dialog box.

Start frequency [THz] Start frequency for FFT.

Stop frequency [THz] Stop frequency for FFT.

Multiplying Whether to multiply.

Threshold angle [deg] Angle criterion for unwrap processing. (0 to 360)

Start frequency [THz] Start frequency for unwrap processing. (0.0000 to 10.0000)

Initial value Initial value for unwrap processing.

Prediction frequency [THz] Correction frequency.

Available range Valid range width.

Re initial value Initial refractive index.

Im initial value Initial extinction coefficient.

Repeat count Number of calculation repetitions.
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 Polarization calculation condition (Polarization Analysis Option)

For polarization analysis data, the following values are valid:

4. 2. 5. 4 Visualization Dialog Box

This dialog box is used to specify the waveform and imaging result colors.

This dialog box opens from the following menus:

• [Visualization...] in 4. 2. 2. 3 "[Options]" on page 4-21

• [Visualization...] in 4. 4. 2. 2 "[Options]" on page 4-48

• [Visualization...] in 5. 2. 2. 3 "[Options]" on page 5-22

• [Visualization...] in 5. 5. 2. 2 "[Options]" on page 5-50

Figure 4-27 Visualization Dialog Box

Coefficient angle[deg] Correction angle of the wire grid

Relative angle1[deg] Relative angle 1 of the wire grid

Relative angle2[deg] Relative angle 2 of the wire grid

Jones Vector frequency[THz] Jones Vector frequency

Jones Vector division number Jones Vector division number
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 Graph tab

Specifies the colors used for waveform display.

[Assignment method of line color] menu

Specifies how to assign colors for Spectrum 1 to 8 to waveforms.

Cyclic Assigns eight waveform colors cyclically.
For example, if there are nine waveforms, the 
first color is assigned to the ninth waveform.

Stretch Handles eight waveform colors as one color 
map and assigns the colors so that the entire 
waveform currently displayed shows the color 
map.
For example, if there are nine waveforms, the 
first color is assigned to the first waveform, the 
eighth color to the ninth waveform, and inter-
polation colors to the remaining waveforms 
according to the color map.

Spectrum1 to 8 Waveform color patterns.
When waveforms overlap, these color patterns are applied starting from Spectrum1.

Selected Color of the selected waveform

Background Background color

Axis Axis color

Grid Grid color

Peak Color of peak annotation

PeakHeight Color of height annotation

PeakArea Color of area annotation

PeakBandwidth Color of area annotation

[Preset...] button Selects a color map to be applied to Spectrum 1 to 8.
Select from the following:

Default Default gradation

Standard Gradation of blue-green-red

AnalogyRed Reddish gradation

AnalogyGreen Greenish gradation

AnalogyBlue Bluish gradation

BlueRedGreen Gradation of blue-red-green

RedGreenBlue Gradation of red-green-blue

GreenBlueRed Gradation of green-blue-red
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 Line Tomography tab

Specifies the colors used for line tomography display.

 Imaging tab

Specifies the colors used for imaging display.

 Colormap Color maps used for line tomography display

Standard Standard gradation

Gray Gray gradation

Red Red gradation

Green Green gradation

Blue Blue gradation

BlueRed Gradation from blue to red

BlueGreen Gradation from blue to green

BlueWhiteRed Gradation from blue to white to red

RedYellowWhite Gradation from red to yellow to white

Rainbow Rainbow color gradation

Colormap Color maps used for imaging display

Standard Standard gradation

Gray Gray gradation

Red Red gradation

Green Green gradation

Blue Blue gradation

BlueRed Gradation from blue to red

BlueGreen Gradation from blue to green

BlueWhiteRed Gradation from blue to white to red

RedYellowWhite Gradation from red to yellow to white

Rainbow Rainbow color gradation

Not Detectable Color for invalid data

Incomplete Color for data not yet measured

Background Background patterns

Gradation Gradation

Monochromatic Single color

Backcolor1 Start color for gradation or the monochromatic color

Backcolor2 End color for gradation

[OK] button Applies the specified settings.

[Cancel] button Closes the dialog box.
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4. 2. 5. 5 Environment Dialog Box

This dialog box is used to specify settings such as the system and display scale settings.

This dialog box opens from the following menus:

• [Environment...] in 4. 2. 2. 3 "[Options]" on page 4-21

• [Environment...] in 4. 4. 2. 2 "[Options]" on page 4-48

• [Environment...] in 5. 2. 2. 3 "[Options]" on page 5-22

• [Environment...] in 5. 5. 2. 2 "[Options]" on page 5-50

Figure 4-28 Environment Dialog Box

 System tab

DataFilePath Directory in which to store system data. It can be changed only offline.

[Browse...] button Specifies the system data directory.
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 Scale1 tab

Specifies the default scale for the waveform.

GraphWindow Vertical Scale Specifies the default scale for the vertical axis.

[Fixed] checkbox When the checkbox is ON, the scale when the waveform is loaded is fixed as the 
minimum and maximum values.
When this checkbox is OFF, the scale is automatically determined.
The same for other Scale tabs.

Max Maximum scale value

Min Minimum scale value

Time Domain [V] Time waveform

Power(Linear) Frequency spectrum

Power(Log) [dB] Frequency spectrum (log display)

Phase [rad] Phase

Phase Shift [rad] Phase difference

Transmittance(Linear) [%] Transmittance, reflectance, and ATR

Transmittance(Log) [dB] Transmittance (log display), reflectance (log display), and ATR (log display)

Absorbance Absorbance

Absorption Coefficient [cm-1] Absorption coefficient

Refractive Index Refractive index 

Extinction Coefficient Extinction coefficient

Permittivity Permittivity

Dielectric Loss Dielectric loss

Voltage Voltage waveform

Normalized Normalized waveform

Log(1/R) Log (1/R) waveform

GraphWindow Horizontal Scale Specify the default scale for the horizontal axis.

Time [psec] Time

Frequency [THz] Frequency

Wavenumbers [cm-1] Number of waves

Wavelength [um] Wavelength

Thickness[um] Thickness



4–37

4. 2 Spectroscopic Measurement Window

6/2/14

 Scale2 tab

Specifies the default scale for the imaging waveform.

 Scale3 tab (polarization analysis option)

Specifies the default scale for polarization analysis data.

4. 2. 5. 6 Print Report Dialog Box

This dialog box outputs reports.

This dialog box opens from the following menu:

• [Print Report...] in 4. 2. 2. 1 "[File]" on page 4-19

• [Print Report...] in 4. 5. 2. 1 "[File]" on page 4-50

LinePlot Scale Specifies the default scale for the vertical axis in the line plot.

Thickness Film thickness

Surface Reflectance Surface reflectance

Interface Reflection Interface reflection

FCSI Film coating strength index

Imaging Range Specifies the default scale for the physical amount (surface color) in 3D display.

Thickness Film thickness

Surface Reflectance Surface reflectance

Interface Reflection Interface reflection

FCSI Film coating strength index

[OK] button Applies the specified setting and closes the dialog box.

[Cancel] button Closes the dialog box.

GraphWindow Polarization Vertical Scale

Ey [V] Ey axis of Ex vs Ey

Phase difference [rad] Phase difference (XY, LR)

Birefringence Birefringence (Linear, Circular)

Retardation [nm] Retardation

Ellipticity Ellipticity

Rotation angle [rad] Rotation angle

Optical Rotation [rad] Optical rotation

Ey Ey axis of Ex vs Ey (Jones Vector)

GraphWindow Polarization Horizontal Scale

Ex [V] Ex axis of Ex vs Ey

Ex Ex axis of Ex vs Ey (Jones Vector)
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• [Print Report...] in 5. 6. 2. 1 "[File]" on page 5-52

• [Print Report...] in 5. 7. 2. 1 "[File]" on page 5-59

• [Print Report...] in 5. 8. 2. 1 "[File]" on page 5-67

• [Print Report...] in 5. 9. 2. 1 "[File]" on page 5-70

• [Print Report...] in 5. 11. 2. 1 "[File]" on page 5-75

Figure 4-29 Print Report Dialog Box

Data Type Displays a data type.

Template Specifies a template appropriate for the data type.

Description Displays a description of the template.

[Report Settings...]button Clicking this command opens the Report Settings dialog box.

 For more information on this dialog box, refer to 4. 2. 5. 7 "Report Set-
tings Dialog Box" on page 4-39.

[Close]button Closes the dialog box.
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Figure 4-30 Preview

Tip
 When shipped, Acrobat Reader is already installed so PDF files can be viewed. However, it is prohibited to

convert a PDF file into a file of a different format by using Acrobat Reader.
 

4. 2. 5. 7 Report Settings Dialog Box

This dialog box sets items to be output to a report.

Page specification From the left side, the first page, previous page, current page, next page, and last 
page buttons.

Print button Prints a report.

Page setting button Sets pages to be printed.

Export button Outputs a report to a TIFF or PDF file.

Zoom button Zooms the preview in or out.
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Figure 4-31 Report Settings Dialog Box

Page Specifies ON or OFF for outputting page numbers.

Print Date and Time Specifies ON or OFF for outputting print date and time.

Data File Path

        Only Filename Outputs only the file name.

        Full Path Outputs the file name by full path.

Advantest Logo Specifies ON or OFF for outputting the Advantest logo.

User Logo Specifies ON or OFF for outputting the user logo.

        [Load...] button Specifies the user logo.

        [Clear] button Clears the user logo.

Comment Describe a comment on measurement data.

[OK] button Applies the specified setting and closes the dialog box.

[Cancel] button Closes the dialog box.
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4. 3 Graph Window in Spectroscopic Measurement 
Window

This section describes the graph window in the Spectroscopic Measurement window.

4. 3. 1 Window Layout

Figure 4-32 shows the user interfaces in the graph window.

Figure 4-32 Graph Window
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4. 3. 2 Tool Bar

The tool bar has the following buttons:

4. 3. 3 Pop-up Menu

The pop-up menu is displayed by right clicking on the graph window.

The pop-up menu contains the following commands:

 [Properties...]

This command opens the Properties dialog box.

 For more information on this dialog box, refer to 4. 3. 4. 1 "Properties Dialog Box" on
page 4-43.

Moves waveform to left.

Moves waveform to right.

Moves waveform up.

Moves waveform down.

Stretches waveform in horizontal axis direction.

Compresses waveform in horizontal axis direction.

Stretches waveform in vertical axis direction.

Compresses waveform in vertical axis direction.

Adjusts display range of horizontal axis to display all data included in current range of 
vertical axis.

Adjusts display range of vertical axis to display all data included in current range of 
horizontal axis.

Scale specification button. Click this button to specify display range in dialog box. 
Clicking this button opens Scale Settings dialog box.

 For more information on this dialog box, refer to 4. 5. 5. 2 "Scale Settings Dia-
log Box" on page 4-78.

Saves screen shot to file. Size of saved image file can be specified from option menu 
on right.



4–43

4. 3 Graph Window in Spectroscopic Measurement Window

6/2/14

4. 3. 4 Dialog Boxes

This section describes dialog boxes.

4. 3. 4. 1 Properties Dialog Box

This dialog box displays detailed waveform information.

This dialog box opens from the following buttons:

• [Properties...] button in 4. 3. 3 "Pop-up Menu" on page 4-42

• [Properties...] button in 4. 5. 4 "Pop-up Menu" on page 4-76

• [Properties...] button in 5. 3. 3 "Pop-up Menu" on page 5-44

• [Properties...] button in 5. 6. 4 "Pop-up Menu" on page 5-54

Figure 4-33 Properties Dialog Box
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 General tab

This tab displays the details of a waveform.

Name Displays the waveform name. The waveform name can be changed.

Last updated Displays the date and time when the waveform was saved last time.

Load path Displays the waveform loading destination. After the waveform is loaded, a waveform is 
not displayed in the Spectroscopic Measurement window.

Comment Displays comments. Comments can be changed.

Condition Displays the measurement conditions and the waveform status.

[Measurement Condition] Group of measurement condition items

Measurement time and date Date and time of measurement

Measurement function Measurement unit

Measurement mode Measurement mode

Frequency resolution Frequency resolution

Cumulated number Waveform cumulated count

Product Product name

Main system System version

Instrument Model name

Firmware Firmware version

[Imaging Information] Group of imaging data items

Display Physical Type Type of display physical quantity

Total Measurement Point Number of measurement points

Axis Resolution[mm] Interval of measurement points

3D Display Space Start[mm] 3D display start point

3D Display Space End[mm] 3D display end point

Coordinates[mm] Measurement coordinates

Multiple Background Data Setting

Whether to execute measurement with multipoint back-
ground data settings

[Spectrum Information] Group of waveform status items

Vertical axis Type of vertical axis

Horizontal axis Type of horizontal axis

Number of points Number of data items to display

Interval of points Interval of data items to display (horizontal axis)

Range of points Range of data items to display (horizontal axis)

Has background Existence of background

[Spectrum Parameters] Group of calculation parameter items

Apodization Window function parameter item
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Enabled Whether to apply the window function

Window order Order of window function

md Amplitude at both edges

div Position of peak data

FFT calculation settings FFT parameter items

Start time [ps] Start point of valid data for FFT execution

Stop time [ps] End point of valid data for FFT execution

Valid data range Data range parameter items

Start frequency [THz] Start frequency for FFT

Stop frequency [THz] Stop frequency for FFT

Multiplying Whether to multiply

Phase unwrap settings Unwrap processing parameter items

Threshold angle [deg] Angle criterion for unwrap processing

Start frequency [THz] Start frequency for unwrap processing

Initial value Initial value for unwrap processing

Absolute phase shift prediction settings

Phase difference parameter items

Prediction frequency [THz] Correction frequency

Available range Valid range width

Refractive index calculation condition

Refractive index parameter items

Number of multiple reflection Number of multiple reflections

Re initial value Initial refractive index

Im initial value Initial extinction coefficient

Repeat count Number of calculation repetitions

Sample thickness[mm] Sample thickness

Calculate List Group of calculation list items

(No) Calculation list application order

Name Calculation name

Parameter Parameter details
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 Annotations tab

This tab displays the annotation setting values.

X X coordinate of annotation

Type Annotation format (Peak/Height/Area/BandWidth)

Value Annotation value

Comment Displayed annotation string

Baseline Start X coordinate at the start point on the baseline (Enabled when Type is Height or 
Area)

Baseline Stop X coordinate at the end point on the baseline (Enabled when Type is Height or 
Area)

Calculate Start X coordinate at the start point in the calculation range (Enabled when Type is 
Area or BandWidth)

Calculate Stop X coordinate at the end point in the calculation range (Enabled when Type is Area 
or BandWidth)

[OK] button Applies changes.

[Cancel] button Closes the Properties dialog box.
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4. 4 Analyze Window
This section describes the Analyze window.

4. 4. 1 Window Layout

Figure 4-34 shows the user interfaces in the Analyze window.

Figure 4-34 Analyze Window

4. 4. 2 Menu Bar

The menu bar contains various pull-down menus for analysis.

4. 4. 2. 1 [File]

The following selections can be made in the [File] menu:

 [File]  [Create New Window]

This command opens an empty graph window.

 [File]  [Load PointData...]

This command loads a spectrum measurement data file.
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 [File]  [Load ImagingData...]

This command loads an imaging measurement data file.

 [File]  [Load JCAMPDX Data...]

This command loads a JCAMP-DX format file.

 [File]  [Load SPCData...]

This command loads an SPC format file.

 [File]  [Close]

This command closes the Analyze window.

4. 4. 2. 2 [Options]

The following selections can be made in the [Options] menu:

 [Options]  [Visualization...]

This command specifies the colors for waveform, background, and other items.

Clicking this command opens the Visualization dialog box.

 For more information on this dialog box, refer to 4. 2. 5. 4 "Visualization Dialog Box" on
page 4-32.

 [Options]  [Environment...]

This command specifies the system data directory or default scale.

Clicking this command opens the Environment dialog box.

 For more information on this dialog box, refer to 4. 2. 5. 5 "Environment Dialog Box" on
page 4-35.

 [Options]  [Report Settings..]

This command sets items output to a report.

Clicking this command opens the Report Settings dialog box.

 For more information on this dialog box, refer to 4. 2. 5. 7 "Report Settings Dialog Box" on
page 4-39.

4. 4. 2. 3 [Window]

The following selections can be made in the [Window] menu:
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 [Window]  [Cascade]

This command cascades graph windows.

 [Window]  [Tile Horizontal]

This command vertically tiles graph windows.

 [Window]  [Tile Vertical]

This command horizontally tiles graph windows.
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4. 5 Graph Window in Analyze Window
This section describes the graph window in the Analyze window.

4. 5. 1 Window Layout

Figure 4-35 shows the user interfaces in the graph window.

Figure 4-35 Graph Window

4. 5. 2 Menu Bar

The menu bar contains various pull-down menus for graph operations.

4. 5. 2. 1 [File]

The following selections can be made in the [File] menu:

 [File]  [Load...]

This command loads a file.
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 [File]  [Save...]

This command saves a graph to a file.

 [File]  [Save all data on the Graph Window ...]

This command saves multiple graphs to a file at once.

Clicking this command opens the Save All Data on the Graph Window dialog box.

 For more information on this dialog box, refer to 4. 5. 5. 1 "Save All Data on the Graph Win-
dow Dialog Box" on page 4-77.

 [File]  [Screen Shot...]

This command saves the screen shot to a file.

 [File]  [Load Calculate List...]

This command loads the calculation list file.

 For more information on the calculation list file, refer to 7. 1 "Calculation List (File)" on
page 7-1.

 [File]  [Save Calculate List...]

This command saves the calculation list to a file.

 For more information on the calculation list file, refer to 7. 1 "Calculation List (File)" on
page 7-1.

 [File]  [Save Report...]

This command saves a report to a file.

 [File]  [Print Report...]

This command prints a report.

Clicking this command opens the Print Report dialog box.

 For more information on this dialog box, refer to 4. 2. 5. 6 "Print Report Dialog Box" on
page 4-37.

 [File]  [Close]

This command closes the graph window.

4. 5. 2. 2 [Horizontal Axis]

The following selections can be made in the [Horizontal Axis] menu:
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 [Horizontal Axis]  [Frequency [THz]]

This command changes the horizontal axis to frequency.

 [Horizontal Axis]  [Wave Numbers [cm-1]]

This command changes the horizontal axis to number of wave numbers.

 [Horizontal Axis]  [Wave Length [um]]

This command changes the horizontal axis to wavelength.

 [Horizontal Axis]  [Time [psec]]

This command changes the horizontal axis to time.

This can be selected only when [Vertical Axis]  [Time Domain [V]] is selected.

4. 5. 2. 3 [Vertical Axis]

The following selections can be made in the [Vertical Axis] menu:

 [Vertical Axis]  [Transmittance(Log) [dB]]

This command changes the vertical axis to transmittance (log display).

 [Vertical Axis]  [Transmittance(Linear) [%]]

This command changes the vertical axis to transmittance.

 [Vertical Axis]  [Reflectance(Log) [dB]]

This command changes the vertical axis to reflectance (log display).

 [Vertical Axis]  [Reflectance(Linear) [%]]

This command changes the vertical axis to reflectance.

 [Vertical Axis]  [ATR(Log) [dB]]

This command changes the vertical axis to ATR (log display).

 [Vertical Axis]  [ATR(Linear) [%]]

This command changes the vertical axis to ATR.

 [Vertical]  [Log(1/R)]

This command changes the vertical axis to Log (1/R). Log (1/R) is calculated as R=Io/I from the
power spectrum (I) of the sample and the reference power spectrum (lo). The same as Absorbance
when the measurement mode is Transmittance.
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 [Vertical Axis]  [Absorbance]

This command changes the vertical axis to absorbance. Executable only when the measurement
mode is Transmittance.

 [Vertical Axis]  [Absorption Coefficient [cm-1]]

This command changes the vertical axis to the absorption coefficient. The absorption coefficient is
calculated from the extinction coefficient. When the measurement mode is Transmission, specify the
Refractive index calculation condition and Sample Thickness in the Parameter Settings dialog box
described in 4. 2. 5. 3 "Parameter Settings Dialog Box" on page 4-29.

 [Vertical Axis]  [Extinction Coefficient]

This command changes the vertical axis to the extinction coefficient. When the measurement mode
is Transmission, specify the Refractive index calculation condition and Sample Thickness in the
Parameter Settings dialog box described in 4. 2. 5. 3 "Parameter Settings Dialog Box" on
page 4-29. When the measurement mode is Reflection or ATR, the extinction coefficient is calcu-
lated from the complex permittivity obtained using the algorithms appropriate for each mode.

 [Vertical Axis]  [Refractive Index]

This command changes the vertical axis to the refractive index. When the measurement mode is
Transmission, specify the Refractive index calculation condition and Sample Thickness in the
Parameter Settings dialog box described in 4. 2. 5. 3 "Parameter Settings Dialog Box" on
page 4-29. When the measurement mode is Reflection or ATR, the refractive index is calculated
from the complex permittivity obtained using the algorithms appropriate for each mode.

 [Vertical Axis]  [Permittivity]

This command changes the vertical axis to permittivity. When the measurement mode is Transmis-
sion, specify the Refractive index calculation condition and Sample Thickness in the Parameter Set-
tings dialog box described in 4. 2. 5. 3 "Parameter Settings Dialog Box" on page 4-29. When
the measurement mode is Reflection or ATR, the permittivity is calculated using the algorithms
which obtain the complex permittivity appropriate for each mode.

 [Vertical Axis]  [Dielectric Loss]

This command changes the vertical axis to dielectric loss. When the measurement mode is Trans-
mission, specify the Refractive index calculation condition and Sample Thickness in the Parameter
Settings dialog box described in 4. 2. 5. 3 "Parameter Settings Dialog Box" on page 4-29.
When the measurement mode is Reflection or ATR, the dielectric loss is calculated using the algo-
rithms which obtain complex permittivity appropriate for each mode.

 [Vertical Axis]  [Phase Shift [rad]]

This command changes the vertical axis to the phase difference.
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 [Vertical Axis]  [Power(Log) [dB]]

This command changes the vertical axis to the frequency spectrum (Log display).

 [Vertical Axis]  [Power(Linear)]

This command changes the vertical axis to the frequency spectrum (Linear display).

 [Vertical Axis]  [Phase [rad]]

This command changes the vertical axis to phase.

 [Vertical Axis]  [Time Domain [V]]

This command changes the vertical axis to the time waveform.

 [Vertical Axis]  [ATR Correction]

This command performs ATR correction.

 For more information on ATR correction, refer to 7. 3 "ATR Correction" on page 7-3.

Note the following points when changing the vertical axis.

Important
 

1. If the vertical axis is changed using the following routes, the already executed calculations in
the calculation list are inherited. Otherwise, the calculation list is cleared.

 For more information on the calculation list, refer to 7. 1 "Calculation List (File)" on
page 7-1.

*1 For Transmittance, when the measurement mode is Transmission, it remains Transmit-
tance. When the measurement mode is Reflection, replace Transmittance with Reflec-
tance, and when the measurement mode is ATR, replace Transmittance with ATR.

2. The selectable vertical axes are limited by the following conditions.
The menus that cannot be selected are inactive.

• Measurement mode

Before change After change

Power(Log) [dB] Transmittance(Log) [dB]

Transmittance(Log) [dB] Transmittance(Linear)[%]

Log(1/R)

Transmittance(Linear)[%] Absorbance

Absorption Coefficient [cm-1]

Extinction Coefficient

Refractive Index

Permittivity

Dielectric Loss
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• Whether the background waveform exists

3. The point which cannot calculate a value in Extinction Coefficient and Refractive Index is dis-
played with the value 30000.
The incalculable cause can consider that a setup of Sample Thickness of a parameter setting
dialog differs from the actual condition.

 

4. 5. 2. 4 [Calculation]

The [Calculation] menu contains the items for data correction and calculation.

 [Calculation]  [Scaling and Offset]

This command opens the Scaling and Offset dialog box. The Scaling and Offset dialog box can be
used to multiply the spectrum by a constant or to apply an offset. Use this dialog box to expand,
reduce, or shift the spectrum.

Figure 4-36 Scaling and Offset Dialog Box

The graph on the top is the one before calculation. The graph on the bottom is the one after calcula-
tion.
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To zoom in to the desired range, drag it with the mouse.

 [Calculation]  [Baseline Correction]

This command opens the Baseline Correction dialog box. The Baseline Correction dialog box is
used to create the baseline along the spectrum and correct the spectrum so that its position becomes
0. Use this dialog box to correct a diagonal spectrum.

Figure 4-37 Baseline Correction Dialog Box

The graph on the top is the one before calculation. The graph on the bottom is the one after calcula-
tion.

To change the shape of the baseline, click on the baseline to create a node and then drag the node. To
move an existing node, select the node by clicking it and then drag it.

A * D1 + B Specify a coefficient in A and an offset in B.

[Zoom Out] button Zooms out of the specified range.

[Execute] button Executes a calculation.

[OK] button Adds the calculation result graph to the Analyze window.

[Cancel] button Closes the dialog box.
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Maximum nodes is 32.

 [Calculation]  [Deconvolution]

This command opens the Deconvolution dialog box. Deconvolution means extracting peak positions
from each band waveform assuming that the measurement waveform consists of band waveforms
with the same width. Deconvolution separates overlapping peaks.

 For more information on deconvolution, refer to 7. 4 "Fourier Self Deconvolution (FSD
Method)" on page 7-4.

Figure 4-38 Deconvolution Dialog Box

Correction method Specifies a baseline type.

Straightline Nodes are connected by a straight line.

Spline Nodes are connected by a spline curve.

Auto The baseline is automatically set. The set baseline is the straight line connecting the start and 
end points that is shifted downward so that it does not touch the waveform.

[Delete] button Deletes the selected nodes from the baseline.

[Reset] button Initializes the baseline.

[Execute] button Executes a calculation.

[OK] button Adds the calculation result graph to the Analyze window.

[Cancel] button Closes the dialog box.
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The graph on the top is the one before calculation. The graph on the bottom is the one after calcula-
tion.

To zoom in to the desired range, drag it with the mouse.

 [Calculation]  [Derivative]

This command opens the Derivative dialog box. The Derivative dialog box is used to differentiate
the spectrum. The difference or Savitzky-Golay method can be selected.

Figure 4-39 Derivative Dialog Box

The graph on the top is the one before calculation. The graph on the bottom is the one after calcula-
tion.

Half bandwidth Specifies a half width.

[Zoom Out] button Zooms out of the specified range.

[Execute] button Executes deconvolution.

[OK] button Adds the calculation result graph to the Analyze window.

[Cancel] button Closes the dialog box.
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To zoom in to the desired range, drag it with the mouse.

 [Calculation]  [FFT Filter]

This command opens the FFT Filter dialog box. The FFT Filter dialog box is used to remove noise
with a certain period from the spectrum. Move the contact point of the filter line while checking the
value in [Period] and adjust the shape of the filter line. Elements with periods smaller than 0.03138
are removed in the following example.

Method Selects a derivative method.

Difference method Difference method

Savitzky-Golay Savitzky-Golay method

Data Points Specifies the number of data points.
(Only an odd number can be entered. It is also possible to select from 3, 5, 7, 9, 11, 13, 
15, 17, 19, 21, 23, and 25.)

Smoothing points Specifies a convolution width.
(Only an odd number can be entered. It is also possible to select from 3, 5, 7, 9, 11, 13, 
15, 17, 19, 21, 23, and 25.)

Derivative order Specifies a derivative order. (1 to 4)

Polynomial order Specifies a polynomial order. (1 to 5)

[Zoom Out] button Zooms out of the specified range.

[Execute] button Executes derivation.

[OK] button Adds the calculation result graph to the Analyze window.

[Cancel] button Closes the dialog box.
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Figure 4-40 FFT Filter Dialog Box

The graph on the top is the one after FFT. The graph on the bottom is the one after calculation.

To zoom in to the desired range, drag it with the mouse.

To change the shape of the filter line, click on the filter line to create a node and then drag the node.
To move an existing node, select the node by clicking it and then drag it.

Maximum nodes is 32.

Position Displays the horizontal axis value of the active node.

Int Displays the vertical axis value of the active node.

Period Displays the period of the active node.

[Delete] button Deletes the active node.

[Reset] button Initializes the filter line.

[Execute] button Initializes the FFT filter.

[Zoom Out] button Zooms out of the specified range.

[OK] button Adds the calculation result graph to the Analyze window.

[Cancel] button Closes the dialog box.
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 [Calculation]  [Interpolation]

This command opens the Interpolation dialog box. The Interpolation dialog box is used to cut out a
range from the spectrum and to interpolate the data in that range. Use this calculation method if a
spectrum with a rounded off data interval is required.

Figure 4-41 Interpolation Dialog Box 

The graph on the top is the one before calculation. The graph on the bottom is the one after calcula-
tion.

To zoom in to the desired range, drag it with the mouse.
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To move the range specification bar, drag it with the mouse.

 [Calculation]  [Normalize]

This command opens the Normalize dialog box. The Normalize dialog box is used to put all data
within the range of 0 (minimum value)to 1 (maximum value). Use this dialog box to compare spec-
trum data.

Method Specifies a method.

Lagrange Lagrange interpolation

 For more information on Lagrange interpolation, refer to 7. 5. 1 "Lagrange 
Interpolation" on page 7-5.

Cubic spline Cubic spline interpolation

 For more information cubic spline interpolation, refer to 7. 5. 2 "Cubic Spline 
Interpolation" on page 7-5.

Cut Only cuts the data.

Start Displays the horizontal axis value of the left range specification bar.

Stop Displays the horizontal axis value of the right range specification bar.

Interval Specifies a data interval.

[Zoom Out] button Zooms out of the specified range.

[Reset] button Initializes the range specification bars.

[Execute] button Interpolates data.

[OK] button Adds the calculation result graph to the Analyze window.

[Cancel] button Closes the dialog box.
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Figure 4-42 Normalize Dialog Box

 [Calculation]  [Peak removal]

This command opens the Peak removal dialog box. The Peak removal dialog box is used to delete
unnecessary peaks. Use this dialog box to remove pseudo peaks known to be noise.

Max Displays the maximum value of the original waveform.

Min Displays the minimum value of the original waveform.

[Execute] button Executes normalization.

[OK] button Adds the calculation result graph to the Analyze window.

[Cancel] button Closes the dialog box.
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Figure 4-43 Peak Removal Dialog Box

The graph on the top is the one before calculation. The graph on the bottom is the one after calcula-
tion.

To zoom in to the desired range, drag it with the mouse.

To move the range specification bar, drag it with the mouse.

 [Calculation]  [Smoothing]

This command opens the Smoothing dialog box. The Smoothing dialog box is used to remove noise
components from the spectrum.

Applying Range

Start Displays the coordinates for the intersection of the left range specification bar and the wave-
form.

Stop Displays the coordinates for the intersection of the right range specification bar and the 
waveform.

[Zoom Out] button Zooms out of the specified range.

[Reset] button Initializes the range specification bars.

[Execute] button Removes unnecessary peaks.

[OK] button Adds the calculation result graph to the Analyze window.

[Cancel] button Closes the dialog box.
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Figure 4-44 Smoothing Dialog Box 

The graph on the top is the one before calculation. The graph on the bottom is the one after calcula-
tion.
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To zoom in to the desired range, drag it with the mouse.

4. 5. 2. 5 [Analysis]

The [Analysis] menu contains the items for data analysis.

 [Analysis]  [Peak Detection]

This command opens the Peak Detection dialog box. The Peak Detection dialog box is used to
detect spectrum peaks.

Smoothing type Specifies a smoothing calculation method. The options are as follows:

Simple moving average Simple moving average method

Savitzky-Golay Savitzky-Golay method

Adaptive smoothing Adaptive smoothing method

Binomial Binomial method

 For more information on each smoothing calculation method, refer to 7. 6 "Smoothing" on 
page 7-6.

Smoothing points Specifies the number of data items.
(Only an odd number can be entered. It is also possible to select from 5, 7, 9, 11, 
13, 15, 17, 19, 21, 23, and 25.)

Polynomial order Specifies a polynomial order. (1 to 5)

Deflection noise Specifies a differential noise value.

Repeat count Specifies the number of repetitions. (1 to 99)

[Zoom Out] button Zooms out of the specified range.

[Execute] button Performs smoothing.

[OK] button Adds the calculation result graph to the Analyze window.

[Close] button Closes the dialog box.
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Figure 4-45 Peak Detection Dialog Box

To zoom in to the desired range, drag it with the mouse.

 [Analysis]  [Peak Height]

This command opens the Peak Height dialog box. The Peak Height dialog box is used to calculate
the height of a peak. The height of the specified peak is calculated with reference to the baseline.

Polarity Specifies the orientation of peaks to detect.
Select from Positive (upward), Negative (downward), and Both (both directions).

Smoothing points Data points used for smoothing. Specify an odd-number value. The smaller the value that is 
specified, the more accurate the peak detection becomes.

Positive threshold Threshold when detecting positive peaks.

Negative threshold Threshold when detecting negative peaks.

[Zoom Out] button Zooms out of the specified range.

[Execute] button Detects peaks.

[Delete] button Deletes the peaks selected in the list.

[OK] button Displays the information on detected peaks in the graph window in the Analyze window.

[Cancel] button Closes the dialog box.
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Figure 4-46 Peak Height Dialog Box

To zoom in to the desired range, drag it with the mouse.

To move the base position specification bar, drag it with the mouse.

 [Analysis]  [Peak Area]

This command opens the Peak Area dialog box. The Peak Area dialog box is used to calculate the
area of a peak. The area specified by the specified horizontal axis range and the baselines is calcu-
lated.

Calculated Height Displays the calculated peak height.

X start Displays the horizontal axis value of the left base position specification bar.

X stop Displays the horizontal axis value of the right base position specification bar.

Peak Displays the horizontal axis value of the peak position specification bar.

[Zoom Out] button Zooms out of the specified range.

[Reset] button Resets the position of each bar.

[Execute] button Calculates the height of the peak.

[OK] button Displays the peak height information in the graph window in the Analyze window.

[Cancel] button Closes the dialog box.
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Figure 4-47 Peak Area Dialog Box

To zoom in to the desired range, drag it with the mouse.

To move the calculation position or baseline specification bar, drag it with the mouse.

 [Analysis]  [Peak Half Bandwidth]

This command opens the Peak Half Bandwidth dialog box. The Peak Half Bandwidth dialog box is
used to calculate the half width of a peak.

Calculated Area Displays the calculated area.

Calculate Range

Start Displays the horizontal axis value of the left calculation position specification bar.

Stop Displays the horizontal axis value of the right calculation position specification bar.

[Baseline] checkbox Check this button to specify the baselines.

Baseline Range

Start Displays the horizontal axis value of the left baseline specification bar.

Stop Displays the horizontal axis value of the right baseline specification bar.

[Zoom Out] button Zooms out of the specified range.

[Reset] button Resets the position of each bar.

[Execute] button Calculates the area of the peak.

[OK] button Displays the peak area information in the graph window in the Analyze window.

[Cancel] button Closes the dialog box.
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Figure 4-48 Peak Half Bandwidth Dialog Box

To zoom in to the desired range, drag it with the mouse.

To move the calculation position specification bar, drag it with the mouse.

 [Analysis]  [Four Arithmetic Operations with Two Spectra]

This command executes an arithmetic operation using two waveforms. Selecting this command first
opens the Data Select dialog box used to specify the waveform data to be used in an arithmetic oper-
ation.

Calculated Half Bandwidth

Displays the calculated half width of the peak.

Calculate Range

Start Displays the coordinates for the intersection of the left calculation position specification bar 
and the waveform.

Stop Displays the coordinates for the intersection of the right calculation position specification 
bar and the waveform.

[Zoom Out] button Zooms out of the specified range.

[Reset] button Resets the position of each bar.

[Execute] button Calculates the half width.

[OK] button Displays the half width information in the graph window in the Analyze window.

[Cancel] button Closes the dialog box.
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Figure 4-49 Data Select Dialog Box

The Four Arithmetic Operations with Two Spectra dialog box is used to execute an arithmetic oper-
ation using spectra.

Figure 4-50 Four Arithmetic Operations with Two Spectra Dialog Box

The graph on the top is the one before calculation. The graph on the bottom is the one after calcula-
tion.

Spectrum1 Selects the first waveform data.

Spectrum2 Selects the second waveform data.

[OK] button Opens the Four Arithmetic Operations with Two Spectra dialog box.

[Cancel] button Closes the dialog box and cancels the operation.
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To zoom in to the desired range, drag it with the mouse.

4. 5. 2. 6 [Polarization] (Polarization Analysis Option)

Important
 The Polarization menu can be used only for data satisfying the following conditions.

• The data was acquired with the transmission module (polarization measurement type).

• Data for two waveforms are displayed, one measured at 45 and the other at -45 of the angle
adjustment lever of the wire grid.

• There is a background waveform.
 

 [Polarization]  [Ex vs Ey [V]]

This command shows a graph of Ex vs Ey.

 [Polarization]  [Phase difference(XY) [rad]]

This command shows a graph of the phase difference between the X and Y components.

 [Polarization]  [Linear Birefringence]

This command shows a birefringence graph.

 [Polarization]  [Retardation [nm]]

This command shows a retardation graph.

 [Polarization]  [Ellipticity]

This command shows an ellipticity graph.

 [Polarization]  [Rotation angle [rad]]

This command shows a rotation angle graph.

A * D1 + B Specifies a coefficient in A and an offset in B.

+    Selects the type of operation.

C * D2 + D Specifies a coefficient in C and an offset in D.

[Zoom Out] button Zooms out of the specified range.

[Execute] button Executes an arithmetic operation.

[Exchange] button Switches the two waveforms (D1 and D2).

[OK] button Adds the calculation result graph to the Analyze window.

[Cancel] button Closes the dialog box.
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 [Polarization]  [Phase difference(LR) [rad]]

This command shows a graph of the phase difference between the left and right rotation compo-
nents.

 [Polarization]  [Circular Birefringence]

This command shows a circular birefringence graph.

 [Polarization]  [Optical Rotation [rad]]

This command shows an optical rotation graph.

 [Polarization]  [Ex vs Ey(Jones Vector)]

This command shows a graph of Ex vs. Ey with the introduction of a Jones vector.

 [Polarization]  [Transmittance(Log)(XY) [dB]]*1

This command shows the transmittance (log) for the X and Y components.

 [Polarization]  [Transmittance(Log)(LR) [dB]]*1

This command shows counterclockwise and clockwise transmittance (log).

 [Polarization]  [Transmittance(Linear)(XY) [%]]*1

This command shows the transmittance (linear) for the X and Y components.

 [Polarization]  [Transmittance(Linear)(LR) [%]]*1

This command shows counterclockwise and clockwise transmittance (linear).

 [Polarization]  [Absorbance(XY)]*1

This command shows the absorbance for the X and Y components.

 [Polarization]  [Absorbance(LR)]*1

This command shows counterclockwise and clockwise absorbance.

 [Polarization]  [Absorption Coefficient(XY) [cm-1]]*1

This command shows the absorption coefficient for the X and Y components.

 [Polarization]  [Absorption Coefficient(LR) [cm-1]]*1

This command shows counterclockwise and clockwise absorption coefficients.

 [Polarization]  [Refractive Index(XY)]*1

This command shows the refractive index for the X and Y components.
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 [Polarization]  [Refractive Index(LR)]*1

This command shows counterclockwise and clockwise refractive indexes.

 [Polarization]  [Extinction Coefficient(XY)]*1

This command shows the extinction ratio for the X and Y components.

 [Polarization]  [Extinction Coefficient(LR)]*1

This command shows counterclockwise and clockwise extinction coefficients.

 [Polarization]  [Permittivity]*1

This command shows the permittivity for the X and Y components.

 [Polarization]  [Dielectric Loss]*1

This command shows the dielectric loss for the X and Y components.

 [Polarization]  [Phase Shift(XY) [rad]]*1

This command shows the phase shift for the X and Y components.

 [Polarization]  [Phase Shift(LR) [rad]]*1

This command shows counterclockwise and clockwise phase differences.

 [Polarization]  [Power(Log) [dB]]*1

This command displays the frequency spectrum (Log display) of X and Y ingredients.

 [Polarization]  [Power(Linear)]*1

This command displays the frequency spectrum (Linear display) of X and Y ingredients.

 [Polarization]  [Phase [rad]]*1

This command shows the phase for the X and Y components.

 [Polarization]  [TimeDomain [V]]*1

This command shows the amplitude of the electric field for the X and Y components.

*1 Two waveforms are shown in a single window.
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4. 5. 3 Tool Bar

The tool bar has the following buttons:

Activates waveform selection mode. Zooming can be performed in this mode.

Activates cursor operation mode.

Activates waveform label selection mode.

Toggles between tile display and cascade display.

Displays or hides waveform list.

Moves waveform to left.

Moves waveform to right.

Moves waveform up.

Moves waveform down.

Stretches waveform in horizontal axis direction.

Compresses waveform in horizontal axis direction.

Stretches waveform in  vertical axis direction.

Compresses waveform in vertical axis direction.

Adjusts display range of horizontal axis to display all data included in current range of 
vertical axis.

Adjusts display range of vertical axis to display all data included in current range of 
horizontal axis.

Scale specification button. Click this button to specify display range in dialog box. 
Clicking this button opens Scale Settings dialog box.

 For more information on this dialog box, refer to 4. 5. 5. 2 "Scale Settings Dia-
log Box" on page 4-78.

Saves screen shot to file. Size of saved image file can be specified from option menu 
on right.
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4. 5. 4 Pop-up Menu

The pop-up menu is displayed by right clicking on the graph window.

The pop-up menu contains the following commands:

 [Copy Calculate List]

This command copies the calculation list.

 For more information on the calculation list file, refer to 7. 1 "Calculation List (File)" on
page 7-1.

 [Copy]

This command copies the graph.

 [Cut]

This command cuts the graph.

 [Paste]

This command pastes the graph.

 [Delete]

This command deletes the graph.

 [Clear Label]

This command deletes all displayed labels.

 [Show Source data]

This command extracts the measurement data for 45 and -45 from the polarization analysis data.
The two data sets are shown overlapping in a new graph window.

 [Show Background]

This command displays the background waveform.

 [Background Settings...]

This command displays the Background Settings dialog box.
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The background waveform for another sample waveform can be applied to the current sample wave-
form.

 For more information on this dialog box, refer to 4. 5. 5. 3 "Background Settings Dialog
Box" on page 4-79.

 [Parameter Settings...]

This command displays the Parameter Settings dialog box.

 For more information on this dialog box, refer to 4. 2. 5. 3 "Parameter Settings Dialog
Box" on page 4-29.

 [Properties...]

This command displays the Properties dialog box.

 For more information on this dialog box, refer to 4. 3. 4. 1 "Properties Dialog Box" on
page 4-43.

4. 5. 5 Dialog Boxes

This section describes dialog boxes.

4. 5. 5. 1 Save All Data on the Graph Window Dialog Box

This dialog box is used to save multiple graphs to a file at once.

The file is saved under the same name as the waveform.

Open this dialog box by clicking [Save all data on the Graph Window...] described in 4. 5. 2.
1 "[File]" on page 4-50.
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Figure 4-51 Save All Data on the Graph Window Dialog Box

4. 5. 5. 2 Scale Settings Dialog Box

This dialog box is used to specify the display ranges of the horizontal and vertical axes in the graph
window.

Open this dialog box by clicking the scale specification button described in 4. 3. 2 "Tool Bar" on
page 4-42 or the scale specification button described in 4. 5. 3 "Tool Bar" on page 4-75.

Path

[Browse...] button Specifies the directory in which to save the file.

Suffix Specifies a suffix to be attached to the file name.

Format Selects a format. The choices are as follows:
TAS7x00 PointData (*.pnt)
CSV (*.csv)
JCAMP-DX (*.jdx)
SPC (*.spc)

[OK] button Saves data to a file.

[Cancel] button Closes the dialog box.
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Figure 4-52 Scale Settings Dialog Box

4. 5. 5. 3 Background Settings Dialog Box

This dialog box is used to apply the background waveform for another sample waveform to the cur-
rent sample waveform.

Open this dialog box by clicking [Background Settings...] described in 4. 5. 4 "Pop-up
Menu" on page 4-76.

Figure 4-53 Background Settings Dialog Box

XAxis Specifies the display range of the horizontal axis.

YAxis Specifies the display range of the vertical axis.

[OK] button Specifies the display range of the graph window.

[Cancel] button Closes the dialog box.

Spectrum Specifies the background waveform.

[OK] button Sets the specified background waveform.

[Cancel] button Closes the dialog box.
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5. Imaging Unit

This chapter describes the Imaging Unit.

The Imaging Unit provides the following functions:

• Allows users to measure the physical quantity of the surface of a tablet and visualize it in a 3D
image. (Imaging Window)

• Allows users to observe the distribution of the physical quantity of a line specified on the surface
of a tablet. (LinePlot Window)

• Allows users to observe the tomographic view of a line specified on the surface of a tablet. (Line-
Tomography Window)

• Allows users to observe the frequency of a physical quantity on the surface of a tablet in a histo-
gram. (Histogram Window)

5. 1 Operating Procedures
This section describes the operating procedures of the Imaging Unit.



5–2

5. Imaging Unit

6/2/14

5. 1. 1 Basic Operations for Measurement

When performing an imaging measurement, it is necessary to attach a cassette, determine analysis
parameters through a prior point measurement, and perform the actual measurement. With this unit,
these operations are performed in the following steps.

The following describes the details of preceding steps:

1) Opening the Measurement window

(1) Opening the Measurement window Initialize the optical unit and manipulator.



(2) Registering tablet shape information Register shape information for the tablet to be measured.



(3) Selecting and attaching a cassette
Select the cassette to be used, from tablet shape information. 
Then, place the reference mirrors and tablets in the target cassette 
and attach it to the main body.



(4) Setting shape information to the cassette Set shape information for each slot of the cassette.



(5) Setting measurement conditions

Set measurement conditions.
The setting contents are as follows:

• General tab: measurement condition name

• Condition tab: axis type, physical quantity type, and wave-
form cumulated count

• Calculate tab: smoothing condition



(6) Point measurement
To determine the parameters for an imaging measurement, mea-
sure a representative point on the tablet.



(7) Determining analysis parameters
Perform an analysis using Time of Flight in the Analysis window 
to determine the parameters for imaging measurement.



(8) Imaging measurement
Use the determined parameters to perform the imaging measure-
ment.
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Click the [Imaging] button in the Navigation window. The Measurement window then opens.
After it opens, execute dry air purge with the  button on the tool bar.

Figure 5-1 Imaging Button

Figure 5-2 Measurement Window

2) Registering tablet shape information
Register shape information for the tablet to be measured. Click the [Shape Definition...] but-
ton in the Tablet Settings for Measurement window. The Simple Tablet Shape Definition dialog
box is then displayed. Enter the tablet shape name and size information, then register by clicking
the [Add/New] button.
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Figure 5-3 Simple Tablet Shape Definition Dialog Box

3) Selecting and attaching a cassette
Selects the cassette to be used. Click the [Setup...] button in the Tablet Settings for Measure-
ment window. The Cassette Select dialog box is then displayed.
Select tablet (or reference mirror) shape information. A list of usable cassettes is then displayed.
From this list, select a cassette.

Figure 5-4 Cassette Select Dialog Box

Place the reference mirrors and tablets in the target cassette and attach it to the main body.

 For more information, refer to "4.5.1 Imaging Unit Cassette Removal/Attachment Procedure"
in TAS7500 Series Terahertz Spectroscopy & Imaging System Instruction Manual.

4) Setting shape information to the cassette
For each slot in the cassette, set shape information on the actually-placed reference mirrors or
tablets. By right-clicking on the slot, candidates are displayed. Select one from the list.
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Figure 5-5 Setting Shape Information to Cassette

5) Setting measurement conditions

a) Select the General tab in the condition setting area of the Measurement window to set mea-
surement conditions.



5–6

5. Imaging Unit

6/2/14

Figure 5-6 General Tab in Condition Setting Area

b) Select the Condition tab in the condition setting area of the Measurement window to set mea-
surement conditions.
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Figure 5-7 Condition Tab in Condition Setting Area

c) Select the Calculate tab in the condition setting area of the Measurement window to set mea-
surement conditions.
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Figure 5-8 Calculate Tab in Condition Setting Area

d) In order to measure the tablet shape, select the Shape Measurement tab in the condition set-
ting area of the Measurement window and set measurement conditions.
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Figure 5-9 Shape Measurement Tab in Condition Setting Area

6) Point measurement

a) In the Slot / Identification area of the Tablet Settings for Measurement window, select a refer-
ence mirror and tablet to be measured.
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b) Specify a slot number for the measurement target in Slot No. for Intended Tablet in the Slot /
Identification area of the Tablet Settings for Measurement window.

c) Press the  button on the tool bar in the Measurement window to execute background
measurement.

d) Set the method for specifying the coordinates to measure in the Point Measurement Settings
area of the Tablet Settings for Measurement window.

e) Press the [Catch] button to catch the tablet.

f) Press the  button on the tool bar in the Measurement window to execute point measure-
ment.

g) Press the [Release] button to return the tablet to the cassette.
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Figure 5-10 Point Measurement

7) Determining analysis parameters
Create an analysis definition file using the point measurement data.

 For more information on the analysis definition file, refer to 7. 7 "Analysis Definition
File" on page 7-7.

a) Press the  button on the tool bar in the Measurement window to transfer the point mea-
surement data to the Analysis window.

b) Click [Analysis]  [Time of Flight Analysis] in the graph window. The Time of Flight
Analysis dialog box then opens. Make adjustments by setting the preprocessing type and
make settings for each layer in this dialog box to correctly calculate the physical quantity.
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Here, the settings for calculating the physical quantity in the first layer are configured as an
example.

• Enter 1, which is the number of the layer to be analyzed, in Total Layers for Analysis.

• Set the time interval for the first layer by dragging the red and green bars in the waveform
display area with the mouse.

• To search for negative peaks, select Negative as the Polarity for 1st under Search Condi-
tion.

• Press the [Execute] button to calculate the physical quantity. If the calculation is per-
formed successfully, "Success" is displayed in the lower part of the dialog box and the val-
ues of the calculated results are displayed in the physical quantity display area.
If the physical quantity cannot be calculated successfully, "Error" is displayed in the lower
part of the dialog box. In such a case, repeat the preceding steps until the calculation is per-
formed successfully.

When the calculation is performed successfully, press the [OK] button to close the dialog box.
A new graph window is displayed in the Analysis window.

Figure 5-11 Time of Flight Analysis Dialog Box

c) Select [File]  [Save Analysis Definition...] in the graph window to save the analysis
parameters to file.

8) Imaging measurement

a) Select the Calculate tab in the condition setting area in the Measurement window and load the
analysis definition file that was created in 7) into Apply specific analysis definition file.
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b) Press the  button on the tool bar in the Measurement window to execute background
measurement.

 For more information on the analysis definition file, refer to 7. 7 "Analysis Definition
File" on page 7-7.

Figure 5-12 Specifying Analysis Definition File

c) Select the Condition tab in the condition setting area of the Measurement window and select
the physical quantity to be displayed in Analysis Setting.

d) Select a tablet to measure in the Slot / Identification area of the Tablet Settings for Measure-
ment window.

Figure 5-13 Specifying Measurement Target Tablet

e) Set the measurement resolution and measuring plane in the Imaging Measurement Settings
area of the Tablet Settings for Measurement window.

Figure 5-14 Specifying Measurement Resolution and Measuring Plane

f) Press the  button on the tool bar in the Measurement window to execute imaging measure-
ment.
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Figure 5-15 Imaging Measurement

g) Use the [Eject] button in the Cassette area of the Tablet Settings for Measurement window to
remove the cassette.

5. 1. 2 Basic Operations for Analysis

The basic operations of the analysis function include the following three steps:

1. Opening the Analysis window

2. Loading the data folder

3. Analyzing the imaging data. In this section, the following operations are performed as examples:

• Observing the distribution of the physical quantity on the surface of a tablet

• Observing the tomographic view of a tablet

The following describes how to perform analysis operations:

1) Opening the Analysis window
Click the [Analysis] button in the Navigation window. The Analysis window then opens.
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Figure 5-16 Analysis Button

Figure 5-17 Analysis Window

2) Loading the data folder
Select [File]  [Load ImagingData...] in the Analysis window to open the folder browser dia-
log box. When a folder (under which the BackGroundData folder exists) in the dialog box is
selected and loaded, the imaging window then opens. An image of the film thickness of the first
layer is displayed.
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Figure 5-18 Imaging Window

3) Displaying the projection drawing of the imaging display.
Click the  button on the tool bar in the imaging window. The projection drawing is then dis-
played. Specify the direction and the line to observe using Projection Direction and Slice Line
Position and check the displayed projection drawing.
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Figure 5-19 Displaying Imaging Projection

4) Opening the LinePlot window to observe the distribution of the physical quantity on the tablet
surface.
After specifying the cross-sectional position of the projection drawing, click the  button in
the projection drawing to open the LinePlot window.
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Figure 5-20 LinePlot Window

5) Opening the LineTomography window to observe the tomographic view of the tablet.
After specifying the cross-sectional position of the projection drawing, click the  button in
the projection drawing to open the LineTomography window.
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Figure 5-21 LineTomography Window
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5. 2 Measurement Window
This section describes the Measurement window.

5. 2. 1 Window Layout

Figure 5-22 shows the user interfaces in the Measurement window.

Figure 5-22 Measurement Window

5. 2. 2 Menu Bar

The menu bar consists of various pull-down menus for measurement.

5. 2. 2. 1 [File]

The [File] menu can be used to make the following selections.

 [File]  [Save Data...]

This command saves the obtained data to file. The sample waveform is saved after a point measure-
ment. The imaging data is saved after an imaging measurement.
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 [File]  [Print Report...]

This command prints a report.

Clicking this command opens the Print Report dialog box.

 For more information on this dialog box, refer to 4. 2. 5. 6 "Print Report Dialog Box" on
page 4-37.

 [File]  [Close]

This command closes the Measurement window.

5. 2. 2. 2 [Measurement]

The [Measurement] menu can be used to make the following selections.

 [Measurement]  [Point Measurement(single)]

This command executes point measurement.

 [Measurement]  [Point Measurement(repeat)]

This command executes point measurement repeatedly.

It is used to see the temporal change of a waveform.

 [Measurement]  [Imaging Measurement]

This command executes imaging measurement.

 [Measurement]  [Background Measurement]

This command executes background measurement.

 [Measurement]  [Plural Sample Imaging Measurement]

This command executes imaging measurement of more than one tablet.

 [Measurement]  [Pause Measurement]

This command temporarily stops imaging measurement. To resume execution of imaging measure-
ment, execute [Measurement]  [Imaging Measurement].

 [Measurement]  [Stop Measurement]

This command stops measurement.

 [Measurement]  [Abort Measurement]

This command terminates measurement.
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 [Measurement]  [Send to Analysis]

This command transfers the obtained data to the Analysis window. The sample waveform is trans-
ferred after a point measurement. The imaging data is transferred after an imaging measurement.

 [Measurement]  [Dry Air Purge]

This command executes dry air purge.

 [Measurement]  [Cover Lock]

This command toggles the lock and unlock of the imaging unit internal cover.

5. 2. 2. 3 [Options]

The [Options] menu can be used to make the following selections.

 [Options]  [Visualization...]

This command sets the color of the waveform and background.

Clicking this command opens the Visualization dialog box.

 For more information on the dialog box, refer to 4. 2. 5. 4 "Visualization Dialog Box" on
page 4-32.

 [Options]  [Environment...]

This command sets the directory and default scale of the system data.

Clicking this command opens the Environment dialog box.

 For more information on the dialog box, refer to 4. 2. 5. 5 "Environment Dialog Box" on
page 4-35.

 [Options]  [Report Settings..]

This command sets items output to a report.

Clicking this command opens the Report Settings dialog box.

 For more information on this dialog box, refer to 4. 2. 5. 7 "Report Settings Dialog Box" on
page 4-39.

5. 2. 2. 4 [Window]

The [Window] menu can be used to make the following selections.
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 [Window]  [Cascade]

This command stacks child windows on top of each other so that only the title bar and left edge is
visible.

 [Window]  [Tile Horizontal]

This command vertically aligns child windows.

 [Window]  [Tile Vertical]

This command horizontally aligns child windows.



5–24

5. Imaging Unit

6/2/14

5. 2. 3 Tool Bar

The tool bar contains the following buttons.

5. 2. 4 Condition Setting Area

This section describes the condition setting area.

Shortcut to [Measurement]  [Point Measurement(single)]

Shortcut to [Measurement]   [Point Measurement(repeat)]

Shortcut to [Measurement]   [Imaging Measurement]

Shortcut to [Measurement]   [Background Measurement]

Shortcut to [Measurement]   [Plural Sample Imaging Measurement]

Shortcut to [Measurement]   [Pause Measurement]

Shortcut to [Measurement]  [Stop Measurement]
When the button is blue, it stops measurement.
When the button is red, it stops measurement forcibly.

Shortcut to [Measurement]  [Abort Measurement]

Shortcut to [Measurement]  [Send to Analysis]

Shortcut to [File]  [Save Data...]

Shortcut to [File]  [Print Report...]

Shortcut to [Measurement]  [Dry Air Purge]
During dry air purge execution, ON is displayed on button.

Shortcut to [Measurement]  [Cover Lock]

Measurement Condition Specifies a measurement name.

[Save...] button Saves the measurement conditions to file.

[Load...] button Loads a measurement condition file.
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5. 2. 4. 1 General Tab

This section describes the General tab.

Prefix Specifies the prefix of the measurement data name.

[Naming Rules...] button Specifies the rules for naming the measurement data.
Clicking this command opens the Naming Rules dialog box.

 For more information on the dialog box, refer to 4. 2. 5. 2 "Naming 
Rules Dialog Box" on page 4-28.

Comment Enter a comment about measurement data.

[Enable auto transfer to analysis] checkbox

Transfers the measurement data automatically to the Analysis window when 
this button is ON.

[Enable auto save] checkbox Automatically saves the measurement data to file when this button is ON.

[Browse...] button Specifies the destination in which to save the measurement data.
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5. 2. 4. 2 Condition Tab

This section describes the Condition tab.

Multiple Background Data Set-
ting

Specifies whether to execute measurement using multipoint background data. 
When On is set, it is executed. When Off is set, it is not executed.

 For more information on multipoint background data, refer to 7. 8 "Tablet 
Area Division and Multipoint Background Data Settings" on page 7-8.

Center Position Correction Specifies whether to execute tablet center position correction or not. When this is 
On, it is executed. When this is Off, it is not executed.

Shape Measurement(Sample) Specifies whether to execute tablet shape measurement. This setting is valid only 
for sample measurement. When On is set, it is executed. When this is Off, it is 
not executed. When On is set, tablet center position correction is not executed 
even if Center Position Correction is set to On.

 For more information on tablet shape measurement, refer to 7. 9 "Tablet 
Shape Measurement" on page 7-11.

Frequency Resolution Displays the frequency resolution.

Vertical Axis Specifies the type of vertical axis.

Normalized Normalized waveform

Voltage Voltage waveform

Power (Log) Frequency spectrum (log display)

Horizontal Axis Specify the type of horizontal axis.

Time [psec] Time
This cannot be selected if Power (Log) is selected as 
the vertical axis type.

Frequency [THz] Frequency
This can only be selected when Power (Log) is 
selected as the vertical axis type.

Wave Number [cm-1] Wave number
This can only be selected when Power (Log) is 
selected as the vertical axis type.

Analysis Setting Specifies the physical quantity to display in the 3D imaging window.

1st Layer Thickness 1st Layer Thickness1st layer film thickness

1st Layer Surface Reflectance

1st layer surface reflectance

1st Layer Interface Reflection

1st layer interface reflection

1st Layer FCSI 1st layer Film Coating Strength Index

2nd Layer Thickness 2nd layer film thickness

2nd Layer Interface Reflection

2nd layer interface reflection

3rd Layer Thickness 3rd layer film thickness
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3rd Layer Interface Reflection

3rd layer interface reflection

4th Layer Thickness 4th layer film thickness

4th Layer Interface Reflection

4th layer interface reflection

5th Layer Thickness 5th layer film thickness

5th Layer Interface Reflection

5th layer interface reflection

Cumulated Number (Sample) Specify the cumulated number of sample measurements.

1 to 16384

Cumulated Number (Background)

Specifies the cumulated number of background measurements.

1 to 16384

[Apply specific background file] button

Specifies a background waveform by file. R1A, R1B, and R1C are the back-
ground waveforms for the top surface of tablets. R2A and R2B are the wave-
forms for the sides. When the check box is set to selected, the specified file 
becomes valid.

 For more information on R1A, R1B, and R1C as well as R2A and R2B, refer 
to 7. 8 "Tablet Area Division and Multipoint Background Data 
Settings" on page 7-8.

[Save...] button Saves the background waveform to file.

[Load...] button Loads the background waveform from a file.
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5. 2. 4. 3 Calculate Tab

This section describes the Calculate tab.

Smoothing

Type Specifies a type of smoothing.

Savitzky-Golay Savitzky-Golay method

None Smoothing is not executed.

Polynomial Specifies a polynomial order. This is enabled when Type is Savitzky-Golay.

Points Specifies the number of data points. This is enabled when Type is Savitzky-Golay.

Apply specific analysis definition file

Displays the name of the analysis definition file that has been loaded.

 For more information on the analysis definition file, refer to 7. 7 "Analysis Definition 
File" on page 7-7.

[Clear] button Clears the analysis definition file.

 For more information on the analysis definition file, refer to 7. 7 "Analysis Definition 
File" on page 7-7.

[Load...] button Loads the analysis definition file.

 For more information on the analysis definition file, refer to 7. 7 "Analysis Definition 
File" on page 7-7.
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5. 2. 4. 4 Shape Measurement Tab

This section describes the Shape Measurement tab.

 For more information on tablet shape measurement, refer to 7. 9 "Tablet Shape
Measurement" on page 7-11.

5. 2. 5 Tablet Settings for Measurement Window

Figure 5-23 shows the user interface of the Tablet Settings for Measurement window.

Fitting Method Specify a type of the function that approximates the tablet shape based on the tablet 
shape measurement result.

Sphere Approximation using a sphere equation

Plane Approximation using a plane equation

Polynominal Approximation using a polynomial equation

Order of the polynomial equation (2 to 6)

Fitting Points Specify the target points when approximating the tablet shape based on the tablet 
shape measurement result.

All Points Approximation of shape using the shape measurement 
data at all points

Circular Neighborhood Approximation using the neighborhood shape measure-
ment data (circular neighborhood) included in the radius 
of the circle specified for each point

Radius[mm] Specifies a circular neighborhood radius.
1 mm to size of tablet (long or short diameter, whichever 
larger)

 For more information on long and short diameters, 
refer to 5. 2. 6. 1 "Simple Tablet Shape Defini-
tion Dialog Box" on page 5-34.

Smoothing Specifies conditions for smoothing the tablet shape measurement result.

Type Specifies a type of smoothing.

Savitzky-Golay Savitzky-Golay method

None Does not execute smoothing.

Polynominal Specifies an order of the polynomial equation (1 to 5).

Points Specifies the number of data points (3 to 1001).
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Figure 5-23 Tablet Settings for Measurement Window

 Tablet

 Cassette

Shape Definition... Registers tablet shape information.

 For more information on the dialog box, refer to 5. 2. 6. 1 "Simple Tablet 
Shape Definition Dialog Box" on page 5-34.

[Eject] / [Inject] button Attaches and removes the cassette.

[Setup...] button Selects the cassette to be used. Clicking this button opens the Cassette Select dialog 
box.

 For more information on the dialog box, refer to 5. 2. 6. 4 "Cassette Select 
Dialog Box" on page 5-41.
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 Slot / Identification

Figure 5-24 Tablet Selection Area

Tablet selection area Specifies a reference mirror and tablet to be measured. Check the slot to be measured.

R1 Reference mirror to measure the top surface.

R2 Reference mirror to measure the side.

Reference tablet for which tablet information has not been set

Sample tablet for which tablet information has not been set

Selected tablet. More than one tablet can be selected at once by dragging mouse. This is tar-
get when setting tablet information by right-clicking.

Reference tablet for which tablet information has been set

Sample tablet for which tablet information has been set. This can be checked as tablet to be 
measured.

Sample tablet that has been checked as measurement target

Slot No. for Intended Tablet Specifies the slot number of the target tablet in order to measure one tablet.

[Start Shape Recognition] button

Starts length measurement to detect the shape of the selected tablet.
The result of the length measurement is saved to a file as shape coordinate data. The 
data can be loaded by pressing the [From File] button in the Tablet Configuration 
Setting dialog box.



5–32

5. Imaging Unit

6/2/14

 Imaging Measurement Settings

Resolution [mm] Specifies the interval of measurement points.
(0.01 to 1/3 of the largest tablet that can be positioned in the tablet cassette)

Portion of the tablet Specifies a portion of the tablet to measure. The selection can be made from the 
following choices:

Top Top surface

Lateral Side surfaces

Bottom Bottom surface

All All surfaces

Top+Lateral Top surface + side surfaces
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 Point Measurement Settings

5. 2. 6 Dialog Box

This section describes the dialog boxes.

 Positioning method Selects a method for specifying the coordinates of the measurement point. The 
selection can be made from the following choices:

Typical position

Specifies a measurement point based on the distance from 
the reference point.

Determined by individual shape data

Specifies a measurement point based on the tablet shape 
image.

Typical position Specifies a measurement point based on the distance from the reference point. The 
selection can be made from the following choices:
Valid only when Typical position is selected for Positioning method.

Center Measures the center position.

Upside from center [mm]

Measures a position which is a specified distance away 
from the center to the top.

Lower side from center [mm]

Measures a position which is a specified distance away 
from the center to the bottom.

Left hand from center [mm]

Measures a position which is a specified distance away 
from the center to the left.

Right hand from center [mm]

Measures a position which is a specified distance away 
from the center to the right.

Distance input range. (0.01 to 1/2 of the longest diameter for the largest tablet that 
can be positioned in the tablet cassette)

[Preview shape data] button Displays the image of the specified tablet.
Clicking this button opens the Singular measurement point setting dialog box.

 For more information on the dialog box, refer to 5. 2. 6. 5 "Singular mea-
surement point setting Dialog Box" on page 5-41.

Valid only when Determined by individual shape data is selected for Positioning 
method.

[Catch] button Catches the tablet.

[Release] button Returns the tablet to the cassette.
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5. 2. 6. 1 Simple Tablet Shape Definition Dialog Box

This dialog box is used to register tablet shape data. This dialog box can be displayed by clicking the
[Shape Definition...] button in 5. 2. 5 "Tablet Settings for Measurement Window" on
page 5-29.
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Figure 5-25 Simple Tablet Shape Definition Dialog Box

Category Specify category to classify shape data. (Can be omitted)

Shape Name Specify name of shape data to be created.

Shape Type Round Circular

Oval Elliptical

Oblong Rectangle with rounded corners

Ellipsoid Creates elliptical top surface of tablet.

Use 'R' for making Creates curved radius top surface of tablet.

Use 'R' and 'R2' 2Rs. Creates double-curvature radius top surface of 
tablet.
(Cannot be selected for Oval.)

flat with bevel edge Flat surface with beveled edge. Creates flat tablet top 
surface with specified-angled circular cone edge. 
(Cannot be selected for Oval.)

convex tablet Flat surface with curved edge. Creates flat top surface 
of tablet with curved edge defined by R. (Cannot be 
selected for Oval.)

Land Creates flat area between tablet diameter and tablet 
top surface shape when this is selected.

Specifications[mm] R Curvature radius (for Oval, curvature radius in short 
diameter direction) (2.525 to 990)

sr Lateral curvature radius in long diameter direction 
when using R for oval tablet (0.5 to 1000)
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sr2 Lateral curvature radius in short diameter direction 
when using R for oval tablet (0 to 1000)

R2 Curvature radius near edge of 2Rs tablet (0 to 10)

dip Angle of inclination near edge for tablet having flat 
surface with beveled edge (1 to 89)

T Height (0.1 to 10)

t Lateral height (0 to T)

a Long diameter (1 to 20)

fa Area where side in long diameter direction is straight 
line (0 to a)

b Short diameter (1 to 20)

fb Area where side in short diameter direction is straight 
line (0 to b)

Land Land area width (0 to 5)

Symmetric Property Symmetrical Creates upside-down shape.

Downside flat Creates shape with flat bottom.

Multiple Background Data Setting

When Shape List displays Sample:

Area decomposition If tablet area division is enabled, ON is displayed. If 
disabled, OFF is displayed.

 For more information on tablet area division, refer 
to 7. 8 "Tablet Area Division and Multipoint 
Background Data Settings" on page 7-8.

Settings... Opens the Area Decomposition Settings dialog box.

 For more information on the dialog box, refer to 
5. 2. 6. 2 "Area Decomposition Settings Dia-

log Box" on page 5-37.

When Shape List displays Reference:

Background position If even one coordinate for executing background mea-
surement is set to the divided area of a tablet, ON is 
displayed. Otherwise, OFF is displayed.

 For more information on tablet area division, refer 
to 7. 8 "Tablet Area Division and Multipoint 
Background Data Settings" on page 7-8.

 For more information on coordinates for execut-
ing background measurement, refer to 5. 2. 6. 
3 "Background Position Settings Dialog 
Box" on page 5-39.

Settings... Opens the Background Position Settings dialog box.

 For more information on the dialog box, refer to 
5. 2. 6. 3 "Background Position Settings Dia-

log Box" on page 5-39.

[Add/New] button Registers shape data.

[Update] Updates shape data selected in shape data area.

[From File] button Loads shape data from file.

[Delete] button Deletes shape data selected in shape data area.



5–37

5. 2 Measurement Window

6/2/14

5. 2. 6. 2 Area Decomposition Settings Dialog Box

This dialog box specifies how the tablet area is divided. This dialog box can be opened by selecting
the Sample tab in Shape List of 5. 2. 6. 1 "Simple Tablet Shape Definition Dialog Box" on
page 5-34 and clicking the [Settings...] button in Multiple Background Data Setting.

 For more information on tablet area division, refer to 7. 8 "Tablet Area Division and Multi-
point Background Data Settings" on page 7-8.

[Close] button Closes dialog box.
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Figure 5-26 Area Decomposition Settings Dialog Box

Top/Bottom Y[mm] Specifies a Y-axis value of the boundary between R1A 
and R1C for the top and bottom surfaces.
The boundary is displayed with horizontal red lines on the 
Top/Bottom figure. The boundary can be moved by click-
ing the mouse on the figure.

Z[mm] Specifies a Z-axis value of the boundary between R1A 
and R1B for the top and bottom surfaces.
The boundary is displayed with vertical red lines on the 
Top/Bottom figure. The boundary can be moved by click-
ing the mouse on the figure.

Lateral Z[mm] Specifies a Z-axis value of the boundary between R2A 
and R2B for the side surface. The boundary is displayed 
with horizontal red lines on the Lateral figure. The bound-
ary can be moved by clicking the mouse on the figure.

[Clear] button Resets the setting values for the top, bottom, and side surfaces to the default values. 
By default, the lines for R1B, R1C, and R2B do not overlap R1A and R2A as shown 
in the figure.

[OK] button Enables the specified setting.

[Cancel] button Closes the dialog box.
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5. 2. 6. 3 Background Position Settings Dialog Box

This dialog box specifies a position of background measurement on the reference and associate
background data with the tablet area. This dialog box can be opened by selecting the Reference tab
in Shape List of 5. 2. 6. 1 "Simple Tablet Shape Definition Dialog Box" on page 5-34 and
clicking the [Settings...] button in Multiple Background Data Setting.

 For more information, refer to 7. 8 "Tablet Area Division and Multipoint Background Data
Settings" on page 7-8.
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Figure 5-27 Background Position Settings Dialog Box

X,Y,Z Displays the cursor location on the reference image. The coordinate axes change 
depending on the selected domain.

Target domain Specifies a domain to be displayed in the tablet figure by selecting a radio button.

Top Displays the top surface.

Lateral Displays the side surface. When Lateral is selected, the side location can be changed 
by using the  and  buttons.

Target Area Specifies the area selected for tablet area division. Background data measured at 
coordinates X, Y, and Z is used in this specified area.

X[mm],Y[mm],Z[mm] Specifies the coordinates of the point to be measured. The coordinate axes change 
depending on the selected domain.

[Apply] button Applies the coordinate values to the target area in the [Tablet area and background 
measurement coordinates table].

[Clear] button Clears the coordinate values from the target area in the [Tablet area and background 
measurement coordinates table].

Tablet area and background measurement coordinates table

Area Displays the tablet area specified in Target Area.

X[mm],Y[mm],Z[mm] Displays the reference coordinates at which background data is measured.

[OK] button Enables the specified setting.

[Cancel] button Closes the dialog box.
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5. 2. 6. 4 Cassette Select Dialog Box

This dialog box is used to apply a cassette to the system. This dialog box can be displayed by click-
ing the [Setup...] button in 5. 2. 5 "Tablet Settings for Measurement Window" on page 5-29.

Select a tablet (or reference mirror) from the shape data area. A list of cassettes that can store it is
then displayed in the cassette area. Select an appropriate cassette from the list and apply it to the sys-
tem by clicking the [Cassette Select] button.

Figure 5-28 Cassette Select Dialog Box

5. 2. 6. 5 Singular measurement point setting Dialog Box

This dialog box is used to set a point to be measured. Point measurement can be executed without
closing this dialog box.

Open this dialog box using the [Preview shape data] button in 5. 2. 5 "Tablet Settings for
Measurement Window" on page 5-29.

Shape data area Displays a list of shape data items for registered tablets (or reference mirrors). 
Select by using the Use check box.

[Sample] button Displays list of tablets in shape data area.

[Reference] button Displays list of reference mirrors in shape data area.

Cassette area Displays list of cassettes that can store tablet (or reference mirror) selected in 
shape data area.

[Cassette Select] button Applies cassette selected in cassette area to system.

[Cancel] button Closes dialog box.
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Figure 5-29 Singular measurement point setting Dialog Box

By clicking on the tablet figure, a point to be measured can be specified.

X,Y,Z Displays cursor location on the tablet figure. Depending on the selected domain, the 
coordinate axes change.

Target domain Specifies a domain to be displayed in the tablet figure by selecting a radio button.

Top Displays the top surface.

Lateral Displays the side surface. When Lateral is selected, the side location can be changed 
by using the  and  buttons.

button Rotates clockwise by 90 degrees.

button Rotates counterclockwise by 90 degrees.

X[mm], Y[mm], Z[mm] Specifies the coordinate of the point to be measured. Depending on the selected 
domain, the coordinate axes change.

[Close] button Closes the dialog box.
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5. 3 Graph Window in Measurement Window
This section describes the graph window of the Measurement window.

5. 3. 1 Window Layout

Figure 5-30 shows the user interface of the graph window.

Figure 5-30 Graph Window

 Physical quantity display area

Layer Layer number

Thickness Film thickness

Surface Reflectance Surface reflectance

Interface Reflection Interface reflection

FCSI Film Coating Strength Index
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5. 3. 2 Tool Bar

The tool bar contains the following buttons.

5. 3. 3 Pop-up Menu

The pop-up menu is displayed by right clicking on the graph window.

The pop-up menu includes the following commands.

 [Properties...]

This command opens the properties dialog box.

 For more information on the dialog box, refer to 4. 3. 4. 1 "Properties Dialog Box" on
page 4-43.

Moves waveform to left.

Moves waveform to right.

Moves waveform upward.

Moves waveform downward.

Expands waveform in direction of horizontal axis.

Compresses the waveform in the direction of the horizontal axis.

Expands waveform in direction of vertical axis.

Compresses waveform in direction of vertical axis.

Adjusts display range of horizontal axis so that all data items located within range of 
current vertical axis can be displayed.

Adjusts display range of vertical axis so that all data items located within range of cur-
rent horizontal axis can be displayed.

Scale specification button. Display range is specified in dialog box. Clicking this but-
ton opens Scale Settings dialog box.

 For more information on the dialog box, refer to 4. 5. 5. 2 "Scale Settings Dia-
log Box" on page 4-78.

Saves the screen shot to file. Use option menu on right to specify size of image file to 
save.



5–45

5. 4 Imaging Window in Measurement Window

6/2/14

5. 4 Imaging Window in Measurement Window
This section describes the imaging window of the Measurement window.

5. 4. 1 Window Layout

Figure 5-31 shows the user interface of the imaging window.

Figure 5-31 Imaging Window

Not Detectable A point where there is a calculation error.

Incomplete A point at which measurement is not carried out.
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5. 4. 2 Tool Bar

The tool bar contains the following buttons.

Toggles imaging rotation mode and cursor display mode. With icon on left, imaging 
display can be rotated using mouse. When icon shows arrow, cursor is displayed.

Toggles display of point waveform. When this button shows ON, point waveform of 
point on imaging display at which mouse has been clicked is displayed. When this but-
ton shows OFF, no point waveform is displayed.

Toggles display of projection drawing. This button is only displayed in imaging win-
dow of Analysis window.

Displays histogram of 3D data. This button is only displayed in imaging window of 
Analysis window.

Starts the gradation view window.

 For more information on the window, refer to 5. 11 "Gradation View Window in 
Analyze Window" on page 5-75.

This button is only displayed in imaging window of Analysis window.

Switches camera for 3D display. Camera switches between the parallel projection cam-
era and perspective projection camera.

Saves screen shot to file. Use option menu on right to specify size of image file to save.

Displays minimum value to maximum value of displayed data in gradient.

Scale setting button. Sets gradient within fixed range using dialog box. Clicking this 
button opens Scale Settings dialog box.

 For more information on the dialog box, refer to 5. 4. 4. 1 "Scale Settings Dia-
log Box" on page 5-47.

Saves the current camera position as the home position. If more than one camera is dis-
played, camera displayed in upper left corner is used.

Moves camera to position saved as home position. If more than one camera is dis-
played, they all move to same position.

Moves camera to position from which top surface of tablet can be shown.

Moves camera to position from which image of bottom surface of tablet can be shown.

Moves camera to position from which image of lateral surface (viewed from + direc-
tion of Y axis) of tablet can be shown.

Moves camera to position from which image of lateral surface (viewed from - direction 
of Y axis) of tablet can be shown.

Moves camera to position from which image of lateral surface (viewed from + direc-
tion of Z axis) of tablet can be shown.
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5. 4. 3 Pop-up Menu

The pop-up menu is displayed by right clicking on the imaging window.

The pop-up menu includes the following commands.

 [Properties...]

This command opens the Properties dialog box.

 For more information on the dialog box, refer to 5. 4. 3. 1 "Properties Dialog Box" on
page 5-47.

5. 4. 3. 1 Properties Dialog Box

This dialog box displays detailed information of imaging data.

This dialog box opens from the following buttons:

• [Properties...] button in 5. 4. 3 "Pop-up Menu" on page 5-47

• [Properties...] button in 5. 7. 3 "Pop-up Menu" on page 5-61

The items displayed in this dialog box are the same as 4. 3. 4. 1 "Properties Dialog Box" on
page 4-43.

5. 4. 4 Dialog Box

This section describes the dialog boxes.

5. 4. 4. 1 Scale Settings Dialog Box

This dialog box is used to set the gradation range of the imaging window. The items of currently dis-
played physical quantity can be entered.

Open this dialog box using the scale setting button in 5. 4. 2 "Tool Bar" on page 5-46.

Moves camera to a position from which image of lateral surface (viewed from - direc-
tion of Z axis) of tablet can be shown.
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Figure 5-32 Scale Settings Dialog Box

Auto Scale checkbox Sets the minimum value and maximum value of the data being displayed.
When the checkbox is on, the minimum and maximum values are enabled.
When it is off, all the data is displayed.

Max Specifies a maximum value for the range to display.

Min Specifies a minimum value for the range to display.

[OK] button Applies the set information.

[Cancel] button Closes the dialog box.
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5. 5 Analysis Window
This section describes the Analysis window.

5. 5. 1 Window Layout

Figure 5-33 shows the user interface of the Analysis window.

Figure 5-33 Analysis Window

5. 5. 2 Menu Bar

The menu bar consists of various pull-down menus for analyses.

5. 5. 2. 1 [File]

The [File] menu can be used to make the following selections.

 [File]  [Create New Window]

This command opens an empty graph window.
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 [File]  [Load PointData...]

This command loads the spectrum measurement data file.

 [File]  [Load ImagingData...]

This command loads the imaging measurement data file.

 [File]  [Load JCAMPDX Data...]

This command loads the JCAMPDX format file.

 [File]  [Load SPCData...]

This command loads the SPC format file.

 [File]  [Close]

This command closes the Analysis window.

5. 5. 2. 2 [Options]

The [Options] menu can be used to make the following selections.

 [Options]  [Visualization...]

This command sets the color of the waveform and background.

Clicking this command opens the Visualization dialog box.

 For more information on the dialog box, refer to 4. 2. 5. 4 "Visualization Dialog Box" on
page 4-32.

 [Options]  [Environment...]

This command sets the directory and default scale of the system data.

Clicking this command opens the Environment dialog box.

 For more information on the dialog box, refer to 4. 2. 5. 5 "Environment Dialog Box" on
page 4-35.

 [Options]  [Report Settings..]

This command sets items output to a report.

Clicking this command opens the Report Settings dialog box.

 For more information on this dialog box, refer to 4. 2. 5. 7 "Report Settings Dialog Box" on
page 4-39.
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5. 5. 2. 3 [Window]

The [Window] menu can be used to make the following selections.

 [Window]  [Cascade]

This command stacks child windows on top of each other so that only the title bar and left edge is
visible.

 [Window]  [Tile Horizontal]

 This command vertically aligns child windows.

 [Window]  [Tile Vertical]

This command horizontally aligns child windows.



5–52

5. Imaging Unit

6/2/14

5. 6 Graph Window in Analysis Window
This section describes the graph window of the Analysis window.

5. 6. 1 Window Layout

Figure 5-34 shows the user interface of the graph window.

Figure 5-34 Graph Window

5. 6. 2 Menu Bar

The menu bar consists of various pull-down menus for manipulating a graph.

5. 6. 2. 1 [File]

The [File] menu can be used to make the following selections.

 [File]  [Save...]

This command saves the graph to file.

 [File]  [Screenshot...]

This command saves the screen shot to file.
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 [File]  [Load Analysis Definition...]

This command loads the analysis definition file.

 For more information on the analysis definition file, refer to 7. 7 "Analysis Definition File" on
page 7-7.

 [File]  [Save Analysis Definition...]

This command saves the analysis parameters to file.

 [File]  [Save Report...]

This command saves a report to a file.

 [File]  [Print Report...]

This command prints a report.

Clicking this command opens the Print Report dialog box.

 For more information on this dialog box, refer to 4. 2. 5. 6 "Print Report Dialog Box" on
page 4-37

 [File]  [Close]

This command closes the graph window.

5. 6. 2. 2 [Horizontal Axis]

The [Horizontal Axis] menu can be used to make the following selections.

 [Horizontal Axis]  [Time [psec]]

This command changes the horizontal axis to time.

 [Horizontal Axis]  [Thickness [um]]

This command changes the horizontal axis to thickness.

 [Horizontal Axis]  [Wave Numbers [cm-1]]

This command changes the horizontal axis to wave number.

 [Horizontal Axis]  [Frequency [THz]]

This command changes the horizontal axis to frequency.

5. 6. 2. 3 [Vertical Axis]

The [Vertical Axis] menu can be used to make the following selections.
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 [Vertical Axis]  [Normalized]

This command changes the vertical axis to normalized waveform.

 [Vertical Axis]  [Voltage]

This command changes the vertical axis to voltage.

 [Vertical Axis]  [Power(Log) [db]]

This command changes the vertical axis to frequency spectrum (log display).

5. 6. 2. 4 [Analysis]

The [Analysis] menu includes a menu for analyses.

 [Analysis]  [Time of Flight Analysis]

This command performs preprocessing for calculating the physical quantity and specifies the range
of layers.

Clicking this command opens the Time of Flight Analysis dialog box.

 For more information on the dialog box, refer to 5. 6. 5. 1 "Time of Flight Analysis Dialog
Box" on page 5-55.

5. 6. 3 Tool Bar

The contents of the tool bar are the same as those described in 5. 3. 2.

5. 6. 4 Pop-up Menu

The pop-up menu is displayed by right clicking on the graph window.

The pop-up menu includes the following commands.

 [Copy Analysis Definition]

This command copies the analysis parameters.

 [Paste]

This command applies the analysis parameters that have been copied.

 [Show Background]

This command displays the background waveform.
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 [Background Settings]

This command displays the Background Settings dialog box.

It applies the background waveform of another sample waveform to the relevant sample waveform.

 For more information on the dialog box, refer to 4. 5. 5. 3 "Background Settings Dialog
Box" on page 4-79.

 [Properties...]

This command opens the properties dialog box.

 For more information on the dialog box, refer to 4. 3. 4. 1 "Properties Dialog Box" on
page 4-43.

5. 6. 5 Dialog Box

This section describes the dialog boxes.

5. 6. 5. 1 Time of Flight Analysis Dialog Box

This dialog box is used to perform preprocessing for calculating the physical quantity and specify
the range of layers.

Open this dialog box from [Analysis]  [Time of Flight Analysis] in the graph window of the
Analysis window.
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Figure 5-35 Time of Flight Analysis Dialog Box

 Waveform display area

Moves waveform to left.

Moves waveform to right.

Expands display range in direction of horizontal axis.

Compresses display range in direction of horizontal axis.

Displays entire range in direction of horizontal axis.

Changes display range of horizontal axis to between Start and 5th, which were specified in 
Search Condition.

Boundary bars Color-coded boundary bars are displayed on the waveform. By dragging these bars, 
the boundaries of the layers can be changed.
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 Condition setting area

 Physical quantity display area

Smoothing Specifies a type of smoothing.

Savitzky-Golay - Savitzky-Golay method.

None - Smoothing is not executed.

Polynomial order Specifies a polynomial order. (1-5) This is enabled when Savitzky-Golay is selected 
for Smoothing.

Smoothing points Number of data points. This is enabled when Savitzky-Golay is selected for Smooth-
ing.

Total Layers for Analysis

Specifies the number of layers for which the physical quantity is calculated. (1-5)

Search Condition

Boundary[ps] Specifies a time value of the layer boundaries.

Polarity Specifies the peak polarity.

Positive - Positive peak

Negative - Negative peak

Don’t Search - No search is performed.

Detection Sensitivity Specifies the peak detection accuracy.(1-10)
The greater the value that is specified, the finer peaks that are detected.

[Execute] button Executes the calculation of the physical quantity.

[OK] button Applies the analysis parameters to the graph window of the Analysis window. A new 
graph window opens.

[Cancel] button Closes the dialog box.

Layer Layer number

Thickness Film thickness

Surface Reflectance Surface reflectance

Interface Reflection Interface reflection

FCSI Film Coating Strength Index
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5. 7 Imaging Window in Analysis Window
This section describes the imaging window of the Analysis window.

5. 7. 1 Window Layout

Figure 5-36 shows the user interface of the imaging window.

Figure 5-36 Imaging Window

Not Detectable A point where there is a calculation error.

Incomplete A point at which measurement is not carried out.
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5. 7. 2 Menu Bar

The menu bar consists of various pull-down menus for manipulating imaging data.

5. 7. 2. 1 [File]

The [File] menu can be used to make the following selections.

 [File]  [Save...]

This command saves the imaging data to folder.

 [File]  [Save as csv file...]

This command saves the imaging data to file in CSV format.

 [File]  [Screenshot...]

This command saves the screen shot to file.

 [File]  [Load Analysis Definition...]

This command loads the analysis definition file. The physical quantity is recalculated with the
loaded analysis parameters.

 For more information on the analysis definition file, refer to 7. 7 "Analysis Definition File" on
page 7-7.

 [File]  [Save Report...]

This command saves a report to a file.

 [File]  [Print Report...]

This command prints a report.

Clicking this command opens the Print Report dialog box.

 For more information on this dialog box, refer to 4. 2. 5. 6 "Print Report Dialog Box" on
page 4-37.

 [File]  [Close]

This command closes the window.

5. 7. 2. 2 [Analysis]

The [Analysis] menu can be used to make the following selections.
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 [Analysis]  [1st Layer Thickness]

This command displays the film thickness of the 1st layer.

 [Analysis]  [1st Layer Surface Reflectance]

This command displays the surface reflectance of the 1st layer.

 [Analysis]  [1st Layer Interface Reflection]

This command displays the interface reflection of the 1st layer.

 [Analysis]  [1st Layer FCSI]

This command displays the FCSI of the 1st layer.

 [Analysis]  [2nd Layer Thickness]

This command displays the film thickness of the 2nd layer.

 [Analysis]  [2nd Layer Interface Reflection]

This command displays the interface reflection of the 2nd layer.

 [Analysis]  [3rd Layer Thickness]

This command displays the film thickness of the 3rd layer.

 [Analysis]  [3rd Layer Interface Reflection]

This command displays the interface reflection of the 3rd layer.

 [Analysis]  [4th Layer Thickness]

This command displays the film thickness of the 4th layer.

 [Analysis]  [4th Layer Interface Reflection]

This command displays the interface reflection of the 4th layer.

 [Analysis]  [5th Layer Thickness]

This command displays the film thickness of the 5th layer.

 [Analysis]  [5th Layer Interface Reflection]

This command displays the interface reflection of the 5th layer.

 [Analysis]  [1st  Layer All Parameter]

This command displays all physical quantities of the 1st layer.
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 [Analysis]  [2nd Layer All Parameter]

This command displays all physical quantities of the 2nd layer.

 [Analysis]  [3rd Layer All Parameter]

This command displays all physical quantities of the 3rd layer.

 [Analysis]  [4th Layer All Parameter]

This command displays all physical quantities of the 4th layer.

 [Analysis]  [5th Layer All Parameter]

This command displays all physical quantities of the 5th layer.

5. 7. 3 Pop-up Menu

The pop-up menu is displayed by right clicking on the imaging window. The pop-up menu includes
the following commands.

 [Background Settings...]

This command applies the background waveform to the relevant imaging data.

 For more information on the dialog box, refer to 5. 7. 4. 1 "Background Settings Dialog
Box" on page 5-62.

 [Merge Imaging Data...]

This command displays the Merge Imaging Data dialog box. Other imaging data items are merged
with the relevant imaging data.

 For more information on the dialog box, refer to 5. 7. 4. 2 "Merge Imaging Data Dialog
Box" on page 5-63.

 [Properties...]

This command opens the Properties dialog box.

 For more information on the dialog box, refer to 5. 4. 3. 1 "Properties Dialog Box" on
page 5-47.

5. 7. 4 Dialog Box

This section describes the dialog boxes.
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5. 7. 4. 1 Background Settings Dialog Box

This dialog box applies the background waveform for another sample waveform to the current sam-
ple waveform.

This dialog box can be opened by clicking [Background Settings...] in 5. 7. 3 "Pop-up
Menu" on page 5-61. If the system version is R3.00 or earlier, Figure 5-37 is displayed. For
R3.01 or later, Figure 5-38 is displayed.

 For more information on the system version, refer to 3. 2 "Menu Bar" on page 3-2.

 For more information on R1A, R1B, and R1C as well as R2A and R2B, refer to 7. 8 "Tablet
Area Division and Multipoint Background Data Settings" on page 7-8.

Figure 5-37 Background Settings Dialog Box (Imaging Data for R3.00 or Earlier)

Spectrum Specifies a background waveform.

[OK] button Sets the specified background waveform.

[Cancel] button Closes the dialog box.
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Figure 5-38 Background Settings Dialog Box (Imaging Data for R3.01 or Later)

5. 7. 4. 2 Merge Imaging Data Dialog Box

This dialog box merges other imaging data items with the relevant imaging data.

Open this dialog box by clicking [Merge Imaging Data...] described in 5. 7. 3 "Pop-up
Menu" on page 5-61.

Figure 5-39 Merge Imaging Data Dialog Box

Spectrum Specifies a background waveform.

[R1A] check box Select this check box to apply to area A on the top surface of the tablet.

[R1B] check box Select this check box to apply to area B on the top surface of the tablet.

[R1C] check box Select this check box to apply to area C on the top surface of the tablet.

[R2A] check box Select this check box to apply to area A on the side surface of the tablet.

[R2B] check box Select this check box to apply to area B on the side surface of the tablet.

[OK] button Sets the specified background waveform.

[Cancel] button Closes the dialog box.

Imaging Specifies the imaging data.

[OK] button Merges the specified imaging data items with the relevant imaging data.

[Cancel] button Closes the dialog box.
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Tip
 

1. If the relevant imaging data is for system version R3.00 or earlier, only imaging data for R3.00 or ear-
lier can be selected for merging.

2. If the relevant imaging data is for system version R3.01 or later, only imaging data for R3.01 or later
can be selected for merging.

3. If background data is set to the relevant imaging data, only imaging data for which background data is
set can be selected.

4. If background data is not set to the relevant imaging data, only imaging data for which background
data is not set can be selected.

 

5. 7. 5 Tool Bar

The contents of the tool bar are the same as those described in 5. 4. 2.
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5. 7. 6 Projection Drawing

Projection drawing allows users to observe the cross-sectional image of a tablet.

Projection Direction Specifies a surface of the tablet to observe. The selection can be made from the fol-
lowing choices.

YZ plane, +Xside Top surface

YZ plane, -Xside Bottom surface

XZ plane, +Yside Lateral surface viewed from the + direction of the Y 
axis

XZ plane, -Yside Lateral surface viewed from the - direction of the Y 
axis

YZ plane, +Zside Lateral surface viewed from the + direction of the Z 
axis

YZ plane, -Zside Lateral surface viewed from the - direction of the Z 
axis

Slice Line Direction Specifies the direction of the line that specifies the cross-sectional surface. The selec-
tion can be made from the following choices.

Vertical Vertical direction

Horizontal Horizontal direction

Slice Line Position Specifies the position of the line that specifies the cross-sectional surface. The line can 
be moved by changing the numerical value.

Opens LinePlot window.

 For more information on the LinePlot window, refer to 5. 8 "LinePlot Window in 
Analysis Window" on page 5-66.

Opens LineTomography window.

 For more information on the LineTomography window, refer to 5. 
9 "LineTomography Window in Analysis Window" on page 5-69.
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5. 8 LinePlot Window in Analysis Window
This section describes the LinePlot window of the Analysis window. The LinePlot window allows
users to observe the distribution of the physical quantity on the cross-sectional surface specified by
the projection drawing.

5. 8. 1 Window Layout

Figure 5-40 shows the user interface of the LinePlot window.

Figure 5-40 LinePlot Window

5. 8. 2 Menu Bar

The menu bar consists of various pull-down menus.

Slice Line Position Displays the position of the cross-sectional line that has been specified by the pro-
jection drawing.
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5. 8. 2. 1 [File]

The [File] menu can be used to make the following selections.

 [File]  [Save as csv file...]

This command saves the LineTomography data to file in CSV format.

 [File]  [Screenshot...]

This command saves the screen shot to file.

 [File]  [Save Report...]

This command saves a report to a file.

 [File]  [Print Report...]

This command prints a report.

Clicking this command opens the Print Report dialog box.

 For more information on this dialog box, refer to 4. 2. 5. 6 "Print Report Dialog Box" on
page 4-37.

 [File]  [Close]

This command closes the window.

5. 8. 3 Tool Bar

The tool bar contains the following buttons:

5. 8. 4 Pop-up Menu

The pop-up menu is displayed by right clicking on the LinePlot window.

Sets mode to zoom mode. Area specified using mouse can be zoomed in.

Sets mode to pointing mode. Cursor is displayed at position of mouse.

Expands display range in horizontal direction.

Expands display range in vertical direction.

Saves screen shot to file. Use option menu on right to specify size of image file to save.
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The pop-up menu includes the following commands.

 [Show Waveform]

This command displays the point waveform of a specified point.
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5. 9 LineTomography Window in Analysis Window
This section describes the LineTomography window of the Analysis window. The LineTomography
window allows users to observe the tomographic view of the cross-sectional surface that has been
specified by the projection drawing.

5. 9. 1 Window Layout

Figure 5-41 shows the user interface of the LineTomography window.

Figure 5-41 LineTomography Window

5. 9. 2 Menu Bar

The menu bar consists of various pull-down menus.

Slice Line Position Displays the position of the cross-sectional line that has been specified by the pro-
jection drawing.
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5. 9. 2. 1 [File]

The [File] menu can be used to make the following selections.

 [File]  [Save as csv file...]

This command saves the LineTomography data to file in CSV format.

 [File]  [Screenshot...]

This command saves the screen shot to file.

 [File]  [Save Report...]

This command saves a report to a file.

 [File]  [Print Report...]

This command prints a report.

Clicking this command opens the Print Report dialog box.

 For more information on this dialog box, refer to 4. 2. 5. 6 "Print Report Dialog Box" on
page 4-37.

 [File]  [Close]

This command closes the window.

5. 9. 2. 2 [View]

The [View] menu can be used to make the following selections.

 [View]  [Scale Unit]  [Time]

This command displays the vertical axis as time.

 [View]  [Scale Unit]  [Thickness]

This command displays the vertical axis as thickness.
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5. 9. 3 Tool Bar

The tool bar contains the following buttons.

5. 9. 4 Pop-up Menu

The pop-up menu is displayed by right clicking on the LinePlot window.

The pop-up menu includes the following commands.

 [Show Waveform]

This command displays the point waveform of a specified point.

5. 9. 5 Dialog Box

This section describes the dialog boxes.

5. 9. 5. 1 Scale Settings Dialog Box

This dialog box is used to set the gradation range of the LineTomography window.

Open this dialog box using the scale setting button in 5. 9. 3 "Tool Bar" on page 5-71.

Sets mode to zoom mode. Area specified using mouse can be zoomed in.

Sets mode to pointing mode. Cursor is displayed at position of mouse.

Expands display range in horizontal direction.

Expands display range in vertical direction.

Displays minimum value to maximum value of displayed data in gradient.

Scale setting button. Sets gradient within fixed range using dialog box. Clicking this button 
opens Scale Settings dialog box.

 For more information on the dialog box, refer to 5. 9. 5. 1 "Scale Settings Dialog 
Box" on page 5-71.

Saves screen shot to file. Use option menu on right to specify size of image file to save.
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Figure 5-42 Scale Settings Dialog Box

Line Tomography

Max Maximum value of the gradation range

Min Minimum value of the gradation range

[OK] button Applies the set information.

[Cancel] button Closes the dialog box.
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5.10 Histogram Window in Analysis Window
This section describes the histogram window of the Analysis window. In the histogram window, the
frequency of a physical quantity is displayed in a histogram. This window is used to check the fre-
quency of a physical quantity on a tablet.

5.10. 1 Window Layout

Figure 5-43 shows the user interface of the histogram window.

Figure 5-43 Histogram Window

The color of the histogram is the same as that of the imaging data in the imaging window.

5.10. 2 Menu Bar

The menu bar consists of various pull-down menus.

Total Measurement points Number of points at which measurement has been carried out

Not Detectable Number of measured points at which a calculation error occurred
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5.10. 2. 1 [File]

The [File] menu can be used to make the following selections.

 [File]  [Save as csv file...]

This command saves the histogram data to file in CSV format.

 [File]  [Screenshot...]

This command saves the screen shot to file.

 [File]  [Close]

This command closes the window.

5.10. 3 Tool Bar

The tool bar contains the following buttons.

Saves screen shot to file. Use option menu on right to specify size of image file to save.
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5.11 Gradation View Window in Analyze Window
This section describes the gradation view window in the Analyze window. By supplementing colors
among data items, the gradation view window displays smooth images.

5.11. 1 Window Layout

Figure 5-44 shows the user interface of the imaging window.

Figure 5-44 Gradation View Window

5.11. 2 Menu Bar

The menu bar consists of various pull-down menus for manipulating imaging data.

5.11. 2. 1 [File]

The following selections can be made in the [File] menu:
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 [File]  [Screenshot...]

This command saves the screenshot to a file.

 [File]  [Save Report...]

This command saves a report to a file.

 [File]  [Print Report...]

This command prints a report.

Clicking this command opens the Print Report dialog box.

 For more information on this dialog box, refer to 4. 2. 5. 6 "Print Report Dialog Box" on
page 4-37.

 [File]  [Close]

This command closes the window.

5.11. 3 Tool Bar

Of the buttons in 5. 4. 2 "Tool Bar" on page 5-46, only the button that saves the screenshot to a
file and the button that adjusts the view are implemented.
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6. PQ/OQ Test

This chapter describes the PQ and OQ tests.

 For more information on the PQ and OQ tests, refer to the instruction manual for each system.
TAS7500: TAS7500 Series Terahertz Spectroscopy & Imaging System Instruction Man-
ual. 
TAS7400: TAS7400 Series Terahertz Spectroscopy System Instruction Manual.

Important
 To display the execution results of a PQ or OQ test, a PDF reader must be installed.
 

6. 1 Operating Procedures
This section describes the operating procedures for performing a PQ or OQ test.

6. 1. 1 Starting PQ/OQ Window

Click the [PQ/OQ] button in the Navigation window. The PQ/OQ window then opens.

Figure 6-1 PQ/OQ Button
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Figure 6-2 PQ/OQ Window

6. 1. 2 Basic Operations Using Spectroscopic Unit

The following describes basic operations using the spectroscopic unit:

1) Set each module to the following status:

Transmission module (Polarization measurement type included)
Remove the object to be measured and install the sample holder (HT-710037) for the trans-
mission module.

Reflection module
Place a reference mirror on the sample holder.

ATR module
Remove the object to be measured.

2) Specify [Spectroscopy] as the measurement function.
The measurement function is fixed to [Spectroscopy] for an independent unit.
Replace [Spectroscopy] with [Spectroscopy(SP)], [Spectroscopy(SL)], or [Spectros-
copy(SU)] according to the connected unit.

3) Select a measurement mode. If the measurement mode is different from the actual measurement
module, the PQ or OQ test cannot be executed.

4) To execute a PQ test, click the PQ button on the tool bar. To execute an OQ test, click the OQ
button on the tool bar. When executing a PQ or OQ test the first time after System Software
starts, the initialization process is executed.
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5) Remove or install the measurement module according to the directions on the screen.

6) When the PQ or OQ test is completed, a report in PDF format is output.
The report is saved in Z:\PQOQ_Report. 
The file name is PQ[SP|SL|SU]_[REF|TR|ATR]_yyyymmdd_hhmm.pdf or 
OQ[SP|SL|SU]_[REF|TR|ATR]_yyyymmdd_hhmm.pdf. For example, for the standard specifica-
tion transmission module, the name of the file that would be created if a PQ test were completed
at 13:15 on August 15, 2012 is "PQSP_TR_20120815_1315.pdf."

7) When the measurement module is set to Reflection, remove the reference mirror.

6. 1. 3 Basic Operations Using Imaging Unit

6. 1. 3. 1 PQ/OQ Test

The following describes the PQ/OQ test using the imaging unit:

1) Place the standard sample on the PQ/OQ cassette. As shown in the following figure, place the
standard sample in the specified orientation and location. When handling the standard sample,
use non-metal tweezers and do not touch it with bare hands.

Important
 If the side or orientation of the placed sample is wrong, a test cannot be executed correctly.
 

Figure 6-3 TH-710036 Standard Sample
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Figure 6-4 How to Set Standard Sample

2) Specify [Imaging] as the measurement function. The measurement function is fixed to [Imag-
ing] for an independent unit.

3) To execute a PQ test, click the PQ button on the tool bar. To execute an OQ test, click the OQ
button on the tool bar. When executing a PQ or OQ test the first time after System Software
starts, the initialization process is executed.

4) The cassette holder moves to the tablet cassette removal/attachment area. Follow the directions
on the screen to attach the cassette prepared in 1). Click the [OK] button to start a PQ or OQ
test.

5) When the PQ or OQ test is completed, a report is output.
The report is saved in Z:\PQOQ_Report. The file name is PQIM_yyyymmdd_hhmm.pdf or
OQIM_yyyymmdd_hhmm.pdf. For example, the name of the file that would be created if an OQ
test were completed at 13:15 on August 15, 2012 is "OQIM_20120815_1315.pdf."

6) The cassette holder moves to the eject position. Follow the directions on the screen to remove the
dedicated cassette in which the correlation standard sample is set.

6. 1. 3. 2 Stage Positioning Accuracy Test

The following describes the stage positioning accuracy test using the imaging unit.

1) Place the standard sample on the stage positioning accuracy test cassette. As shown in the fol-
lowing figure, place the standard sample in the specified orientation and location. When handling
the standard sample, use non-metal tweezers and do not touch it with bare hands.

Important
 If the sample is placed backwards, tests cannot be executed correctly.
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Figure 6-5 How to Set Standard Sample

2) Specify [Imaging] as the measurement function. The measurement function is fixed to [Imag-
ing] for independent units.

3) To execute a stage positioning accuracy test, click the Stage positioning accuracy test button on
the tool bar. The initialization process is executed when executing this test for the first time after
System Software starts.

4) The cassette holder moves to the tablet cassette removal/attachment area. Follow the directions
on the screen to attach the cassette prepared in 1). Click the [OK] button to start a stage position-
ing accuracy test.

5) When the stage positioning accuracy test is completed, a report is output. The report is saved in
Z:\PQOQ_Report. The file name is StagePos_yyyymmdd_hhmm.pdf. For example, the name of
the file created when an optical diagnosis is completed at 13:15 on August 15, 2012 is
"StagePos_20120815_1315.pdf."

6) The cassette holder moves to the eject position. Follow the directions on the screen to remove the
special cassette in which the correlation standard sample is set.
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6. 2 PQ/OQ Window
This section describes the PQ/OQ window.

6. 2. 1 Window Layout

Figure 6-6 shows the user interface in the PQ/OQ window.

Figure 6-6 PQ/OQ Window

6. 2. 2 Menu Bar

The menu bar consists of various pull-down menus for PQ and OQ tests.

6. 2. 2. 1 [File]

The following selections can be made in the [File] menu:

 [File]  [Load Report...]

This command displays a report of PQ or OQ test results using PDF Reader.

 [File]  [Close]

This command closes the PQ/OQ window.
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6. 2. 2. 2 [PQ/OQ]

The following selections can be made in the [PQ/OQ] menu:

 [PQ/OQ]  [Performance Qualification]

This command executes a PQ test.

 [PQ/OQ]  [Operational Qualification]

This command executes an OQ test.

 [PQ/OQ]  [Stage positioning accuracy test]

This command executes a stage positioning accuracy test using the imaging unit.

 [PQ/OQ]  [Stop Measurement]

This command stops measurement.

 [PQ/OQ]  [Abort Measurement]

This command terminates measurement. The measurement data is discarded.

 [PQ/OQ]  [Cover Lock]

This command toggles the lock and unlock of the imaging unit internal cover.

6. 2. 2. 3 [Options]

The following selections can be made in the [Options] menu:

 [Options]  [Visualization...]

This command sets the color of the waveform and background.

Clicking this command opens the Visualization dialog box.

 For more information on the dialog box, refer to 4. 2. 5. 4 "Visualization Dialog Box" on
page 4-32.

 [Options]  [Environment...]

This command specifies where to save system data and the default scale.

Clicking this command opens the Environment dialog box.

 For more information on the dialog box, refer to 4. 2. 5. 5 "Environment Dialog Box" on
page 4-35.
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 [Options]  [Advanced settings...]

This command provides advanced setting functions for maintaining the performance of this analysis
system.

Tip
 About the [Advanced settings...] command

The [Advanced settings...] command is provided to specify advanced settings for maintaining the per-
formance of this analysis system. When this command is specified, a dialog box that prompts the user to
input a password is displayed. This function is provided only when the entered password is correct. If this
command is inadvertently specified, it can be stopped by clicking the [Close] button in the displayed dia-
log box. This command is for use by authorized persons who have attended maintenance training con-
ducted by Advantest Corporation.

 

6. 2. 3 Tool Bar

The tool bar contains the following buttons.

6. 2. 4 Condition Setting Area

This section describes the condition setting area.

Shortcut to [PQ/OQ]  [Performance Qualification]

Shortcut to [PQ/OQ]  [Operational Qualification]

Shortcut to [PQ/OQ]  [Stage positioning accuracy test]

Shortcut to [PQ/OQ]  [Stop Measurement]

Shortcut to [PQ/OQ]  [Abort Measurement]

Shortcut to [PQ/OQ]  [Cover Lock]

Measurement Function Specifies the measurement function.

Measurement Mode Selects the measurement mode for the spectroscopic unit.

Frequency Resolution Displays the frequency resolution during measurement. 
For the TAS7400, specify a frequency resolution.

PQ/OQ Result Displays the PQ or OQ test result.
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6. 2. 5 Result Display Area

The log display area displays the execution results and judgment values of the evaluation items.
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6. 3 Graph Window in PQ/OQ Window
 For more information on the graph window, refer to 4. 3 "Graph Window in Spectroscopic

Measurement Window" on page 4-41.
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7. Glossary

This chapter describes the terms used in this manual.

7. 1 Calculation List (File)
The calculation list is a list in which calculations applied to waveform data are recorded.

The calculations from the following menus in the Analyze window are recorded:

The file in which the calculation list is saved is called the calculation list file.

[Horizontal Axis] menu

[Vertical Axis] menu

[Calculation] menu
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7. 2 Phase Unwrap Processing
The phase is a value between - and . If the phase difference between adjacent points is larger than
a certain value, the phases must be connected by adding or subtracting 2.

This operation is called phase unwrap.

The Parameter Settings dialog box can be used to specify the angle criterion for determining the
phase difference that requires correction and the start frequency for unwrap processing.
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7. 3 ATR Correction
The absorbing capacity of the spectrum measured with the ATR method changes depending on the
number of waves.

ATR correction means correcting this change with a straight ramp function of the wavelength to
approximate it to the transmission spectrum.
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7. 4 Fourier Self Deconvolution (FSD Method)
With the Fourier self deconvolution method, analysis is performed assuming that the measurement
waveform consists of overlapping Lorentz waveforms with the same width.

Because the horizontal axis information is extracted at the sacrifice of the vertical axis information
with this method, only the peak position of each band has a physical meaning in the waveform after
the processing.
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7. 5 Data Interpolation
Data interpolation means calculating the interpolation function that passes through all the measure-
ment data points and estimating the function values other than measurement data points.

7. 5. 1 Lagrange Interpolation

Lagrange interpolation means calculating the interpolation function that passes through all the data
points in the specified range and interpolating data with the calculated function.

This interpolation function is called the Lagrange polynomial.

The disadvantage of Lagrange interpolation is that the interpolation function creates waves if there
are a lot of data items.

7. 5. 2 Cubic Spline Interpolation

Cubic spline interpolation means calculating the cubic functions between each data point in the
specified range and interpolating data with the calculated functions.

The cubic functions for each region are connected so that the first and second derived functions
match at the node.

Unlike Lagrange interpolation, cubic spline interpolation is not negatively affected by a large num-
ber of data items.
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7. 6 Smoothing
Smoothing removes noise components from the spectrum.

7. 6. 1 Simple Moving Average Method

The moving average method is a method to appropriately weight the target point and the points
before and after it and average them.

A rectangular function is used as the weighting function in the simple moving average method.
Therefore, data is very distorted though the smoothing effect is large.

Use the simple moving average method when the signal component is sufficiently smoother than the
noise components.

7. 6. 2 Savitzky-Golay Method

The weighting coefficient defined by Savitzky-Golay is used in the Savitzky-Golay method.

The smoothed value is calculated by multiplying the specified data width by the weighting coeffi-
cient.

The Savitzky-Golay method can be used to remove noise from most spectra.

7. 6. 3 Adaptive Smoothing Method

The smoothed value is calculated from the smoothed value calculated with the simple moving aver-
age method and the specified differential noise in the adaptive smoothing method.

With this method, there is almost no distortion in the peak parts, but the smoothing effect is large in
the baseline part. This method is effective in removing the noise components from a sharp spectrum.

7. 6. 4 Binomial Method

A binomial coefficient is used as the weighting coefficient in the binomial method.

The smoothed value is calculated from three points (target point and arbitrary points before and after
it). This operation is repeated the specified number of times. This method has advantages over the
Savitzky-Golay method. For example, the waveform is not distorted in whole and the phase is not
shifted.
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7. 7 Analysis Definition File
The analysis definition file stores parameters used to calculate physical quantities.

In this file, smoothing settings and the time range corresponding to each layer of a tablet, which
have been set in the Time of Flight Analysis dialog box, are stored.

The physical quantities can be displayed at the time of imaging measurement by loading this file
using Apply specific analysis definition file in the Measurement window.
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7. 8 Tablet Area Division and Multipoint Background 
Data Settings

The tablet area division function is used to divide a tablet into multiple areas.

The multipoint background data setting function is used to set up reference background data for each
divided area.

The area around the center of a tablet was measured during conventional reference background mea-
surement. Take an oblong tablet for example. The curvature around the center and around the edge
are different. If the background data at the center of the tablet is applied to calculate the physical
quantity around the edge, differences in background data are included in the calculation result,
degrading the measurement accuracy.

Tablet area division and multipoint background data settings divide the area into the center of the
tablet and the area around the edge and applies different background data to each area for more
accurate imaging measurement than before.

Figure 7-1 Tablet Area Division and Multipoint Background Data Settings

When applying background data acquired using multipoint background data settings to a tablet the
area of which is divided for sample measurement, set On to Multiple Background Data Setting in 5.
2. 4. 2 "Condition Tab" on page 5-26.
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7. 8. 1 Tablet Area Division

Use 5. 2. 6. 2 "Area Decomposition Settings Dialog Box" on page 5-37 to specify tablet area
division settings. The top surface can be divided into three areas (R1A, R1B, and R1C) while the
side surface can be divided into two areas (R2A and R2B). Figure 7-2 is an example of an oblong
tablet for which the area has been divided.

Figure 7-2 Image of Oblong Tablet Area Division

Tip
 The settings for the top surface apply to the bottom surface as well.
 

7. 8. 2 Multipoint Background Data Settings

For multipoint background data settings, specify the background measurement position on the refer-
ence and the tablet area by using 5. 2. 6. 3 "Background Position Settings Dialog Box" on
page 5-39. Figure 7-3 is an example of multipoint background data settings for oblong tablets.
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Figure 7-3 Image of Multipoint Background Data Settings for Oblong Tablets

To use a reference for which multipoint background data settings are valid, insert the reference at the
R1 position in the cassette to execute background measurement.

Figure 7-4 Position in Cassette for Reference for which Multipoint Background 
Data Settings Are Valid

Important
 When using a reference for which multipoint background data settings are valid, only R1 is mea-

sured even if both R1 and R2 are checked before background measurement.
 

Tip
 The settings for the top surface apply to the bottom surface as well.
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7. 9 Tablet Shape Measurement
The tablet shape measurement function traces the tablet shape using the laser length measuring
machine and executes imaging measurement according to the trace result. This function allows for
more accurate imaging measurement than before.

To perform imaging measurement using tablet shape measurement, set Shape Measurement(Sam-
ple) in 5. 2. 4. 2 "Condition Tab" on page 5-26 to On.

Important
 

• Tablet shape measurement is valid only for imaging measurement. This setting is ignored for
point measurement.

• Tablet shape measurement is valid only for sample measurement. This setting is ignored for
background measurement.

• When tablet shape measurement is On, the settings for tablet center position correction are
ignored.

 For more information on tablet center position correction, refer to 5. 2. 4. 2 "Condition
Tab" on page 5-26.

• Only the top and bottom surfaces are processed during tablet shape measurement. The lat-
eral surface is not processed. If the measured area contains the lateral surface (e.g. All or
Top+Lateral), note that shape measurement and center correction are not executed for the
lateral surface. To achieve highly accurate imaging data for the tablet as a whole, it is recom-
mended to merge the imaging data of the lateral surface measured with center correction to
the imaging data for the top and bottom surfaces measured by shape measurement.

 For more information on the portion to be measured, refer to 5. 2. 5 "Tablet Settings for
Measurement Window" on page 5-29.

 For more information on tablet center position correction, refer to 5. 2. 4. 2 "Condition
Tab" on page 5-26.

 For more information on imaging data merging, refer to 5. 7. 4. 2 "Merge Imaging Data
Dialog Box" on page 5-63.
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8. Using System Software Offline

This chapter describes how to install and uninstall the system software when using it offline and
how to register the license.

8. 1 Installing Software
The procedure for installing the software is as follows:

1) Open Inventor license registration (for first installation)
To operate this software offline, an Open Inventor license is required. Prepare the password
received from Advantest.

Tip
 For the TAS7400, a license for Open Inventor does not need to be registered.

Skip step 1).
 

Figure 8-1 Example Password

Create the following file and enter the preceding password:

2) When executing reinstallation to upgrade the version, first uninstall the old version with the pro-
cedure in 8. 2 "Uninstalling Software" on page 8-3.

3) Put the Offline Analysis Software installation CD in the disk tray.

4) Use Explorer to display the folders on the CD-ROM.

5) Click InstallTAS7x00SystemSoftwareOffline.bat with the right mouse button.

# License IVOL+41233
FEATURE VolumeViz mcslmd 9.2 permanent uncounted \
        VENDOR_STRING=IVOL+41233 HOSTID=d4ae19c3635e \
        ISSUED=11-nov-2012 SIGN=4E123412B656
# End license
# License IOIV+41234
FEATURE OpenInventor mcslmd 9.2 permanent uncounted \
        VENDOR_STRING=IOIV+41234 HOSTID=d4ae19c3635e \
        ISSUED=11-nov-2012 SIGN=C11234EEA114

C:\TAS7500\password.txt
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6) Execute [Run as administrator (A) ...].

7) The User Account Control dialog box opens. Click the [OK] button to start installation.

• Microsoft Visual C++ 2010 redistributable package (x64)
The Microsoft Visual C++ 2010 x64 Redistributable Setup dialog box opens up during installa-
tion. Check I accept to install the software.
If the software is already installed, the Microsoft Visual C++ 2010 x64 Redistributable Mainte-
nance dialog box opens. In this case, click the [Cancel] button to exit.

• Microsoft .NET Framework 4 (stand-alone installer)
The Microsoft .NET Framework 4 Setup dialog box opens during installation. Check I accept to
install the software.
If the software is already installed, the Microsoft .NET Framework 4 Maintenance dialog box
opens. In this case, click the [Cancel] button to exit.

• Microsoft Report Viewer 2010 redistributable package
The Microsoft ReportViewer 2010 Redistributable Setup dialog box opens during installation.
Check I accept to install the software.
If the software is already installed, the Microsoft ReportViewer 2010 Redistributable Mainte-
nance dialog box opens. In this case, click the [Cancel] button to exit.
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8. 2 Uninstalling Software
The procedure for uninstalling the software is as follows:

1) Select [Start]  [All Programs]  [TAS7x00]  
[Uninstall TAS7x00 <version>] (<version> represents system software version) and click it
with the right mouse button.

2) Select [Run as administrator (A) ...].

3) The User Account Control dialog box opens. Click the [OK] button to start uninstallation.
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8. 3 Registering License
This section describes a procedure needed to enable the functions of this software.

1) Prepare the password sheet sent by Advantest.

Figure 8-2 Sample Password Sheet (CpuFixed)

2) Select [Start]  [All Programs]  [Accessories]  [Command Prompt] and click it
with the right mouse button, and then click [Run as administrator (A) ...].

3) To register a license, enter the command using the one line that begins with "CpuFixed 000 ..."
(shown in Figure 8-2) as an argument.
The following shows an example.

Figure 8-3 Example of License Server

L i c e n s e  P a s s w o r d  S h e e t
                                                Date of issue: 2012/02/17
Serial#:  C050012
# Product Number              -> PYSA75-00M
# License Type                -> CpuFixed
# Expiration Client License   -> 000
# Password                    -> AA9DCC963F0B685A9FDF710091C164E9A
# Expiration Date             -> 2017/03/22
# Number of License           -> 1
#***** license *****
CpuFixed 000 AA9DCC963F0B685A9FDF710091C164E9A 00000edcba98 PYSA75-00M
2017/03/22 1 00000edcba98       Enter this one line.

C:\>%PLMS_ROOT%\bin\License_Add  CpuFixed 000 AA9DCC963F0B685A9FDF710091C164E9A0
00000edcba98 PYSA75-00M 2017/03/22 1 00000edcba98
License Added
C:\>
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9. Coating Quality Analysis Option

This chapter describes the coating quality analysis option.

9. 1 Functions of Option
There are four types of physical quantities that can be displayed in imaging measurement and analy-
sis as follows:

The physical quantities other than film thickness can only be displayed when the coating quality
analysis option is applied.

All of the procedures and figures used in this manual are described with this option applied.

Thickness Film thickness

Surface Reflectance Surface reflectance

Interface Reflection Interface reflection

FCSI Film Coating Strength Index
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9. 2 Registering License
 For more information on how to register the license, refer to 8. 3 "Registering License" on

page 8-4.
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10. Polarization Analysis Option

10. 1 Functions of Option
The polarization analysis option allows polarization measurement using the polarization module
(polarization measurement type) and polarization measurement data analysis.

The functions described as (polarization analysis option) in this manual are enabled when a license
is registered.
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10. 2 Registering License
 For more information on how to register the license, refer to 8. 3 "Registering License" on

page 8-4.
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11. FDA Compatible Function Option

This chapter describes the FDA*1 compatible function option.

*1 FDA:U.S.Food and Drug Administration

11. 1 Functions of Option
This option can handle electronic records and signatures instead of printed documents and handwrit-
ten signatures, and supplies functions compliant with the 21 CFR Part 11*1 regulation.

*1 21 CFR Part11:Title 21 CFR Part 11 of the Code of Federal Regulations for the United States (guide-
lines on electronic records and signatures)
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11. 2 Registering License
 For more information on the license, refer to 8. 3 "Registering License" on page 8-4.
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11. 3 Setting and Managing Database
This option uses a database for data management, so Microsoft®SQL Server®2012 Express
(included database) is installed at the same time.

The login ID, initial password, and ODBC data source name for the included database are as fol-
lows:

Important
 

The database size is limited to 10 GB in Microsoft® SQL Server® 2012 Express.

This option can be also connected to Microsoft® SQL Server® 2005, 2008, 2008 R2, and 2012.
Data of 10 GB or greater can be stored by preparing one of these separately.

 

11. 3. 1 Creating Database

This section describes how to create the database used with this option.

This operation should be performed on the server to be connected. Microsoft® SQL Server® 2012 is
used as an example.

Tip
 This operation is not required if using the included database because it is created when this option is

installed.
 

1) Click [Start]  [All Programs]  [Microsoft SQL Server 2012]  [SQL Server Man-
agement Studio] to start SQL Server Management Studio.

2) Enter the following items and click the [Connect] button:

Login ID: sa

Initial password: tas7500database

ODBC data source name: TAS7500DB

Server name: Name of server to be connected

Authentication: SQL Server authentication

Login: Login ID

Password: Password



11–4

11. FDA Compatible Function Option

6/2/14

Figure 11-1 Connecting to Server

3) Right-click "Databases" in Object Explorer and select [New Database].

Figure 11-2 Object Explorer

4) Select [General] in the New Database dialog box, enter the following items, and click the [OK]
button:

Database name: TAS7500DB
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Figure 11-3 New Database

The creation of a database is now complete.

11. 3. 2 Registering ODBC Connection Settings

This section describes how to register ODBC connection settings to the system controller.

Tip
 This operation is not required if using the included database because ODBC connection settings are regis-

tered when this option is installed.
 

1) Click [Start]  [Control Panel]  [System and Security]  [Administrative Tools]
 [Data Sources (ODBC)].

2) Select the System DSN tab and click the [Add] button.
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Figure 11-4 System DSN

3)  Select "SQL Server" and click the [Finish] button.

Figure 11-5 Creating New Data Source

4) Enter the following items and click the [Next] button:

Name: ODBC data source name (arbitrary value)

Server: Name of server to be connected
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Figure 11-6 Entering Server Name

5) Enter the following items and click the [Next] button.
Select "With SQL Server authentication using a login ID and password entered by the user." 

Figure 11-7 Entering Login ID

Login ID: Login ID

Password: Password
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6) Select the "Change the default database to:" checkbox, select "TAS7500DB," and click the
[Next] button.

Figure 11-8 Entering Default Database

7) Click the [Finish] button.

The registration of ODBC connection settings is now complete.

11. 3. 3 Initial Settings

Before using this option for the first time, specify database connection settings and register the user
as the initial settings.

1)  Click [User]  [Database Settings] in the Navigation window to open the Database Set-
tings dialog box.

 For more information on the Database Settings dialog box, refer to 11. 3. 4 "Database Set-
tings Dialog Box" on page 11-9.

2)  The User Account Control dialog box opens. Click the [OK] button.

3) Enter the following items and click the [Test connection] button to verify that the database
can be connected:

ODBC DSN: ODBC data source name

Login ID: Login ID

Password: Password
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Figure 11-9 Database Connection Settings

4) Click the [Update file] button and then click the [Close] button to close the Database Settings
dialog box.

5) Log in for the first time.
Click [User]  [Login] in the Navigation window to open the Login dialog box.

Enter the preceding user ID and password to log in.

 For more information on logging in, refer to 11. 11. 1 "Login Dialog Box" on page 11-25.
After logging in, register the user.

 For more information on user registration, refer to 11. 11. 3 "User Account Settings Dialog
Box" on page 11-27.

11. 3. 4 Database Settings Dialog Box

The Database Settings dialog box can be used to update database connection settings and to create,
back up, and restore tables.

Open this dialog box by clicking [User]  [Database Settings] in the Navigation window.

Tip
 Windows administrator authorization is required to activate this dialog box.
 

When the User Account Control dialog box opens, click the [OK] button.

User ID: Admin

Password: tas7500
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Figure 11-10Database Settings Dialog Box

11. 3. 5 Migrating Database Data

Use the DTSWizard SQL Server tool to migrate data from the included database to another data-
base.
Create a database on the migration destination server before starting the operation.

 For more information on how to create a database, refer to 11. 3. 1 "Creating Database" on
page 11-3.

1) Click [Start]  [All Programs]  [Microsoft SQL Server 2012]  [Import and Export
Data (64-bit)] to start DTSWizard.

[ODBC DSN] Enter the ODBC data source name to be connected.

[Login ID] Enter the login ID.

[Password] Enter the password. Entered characters are masked with asterisks(*).

[Test connection] but-
ton

Executes a database connection test.
When the connection test is successful, the [Update file] and [Create tables] but-
tons are enabled. The [Backup] and [Restore] buttons are also enabled in 
online mode only.

[Update file] button Updates database connection settings.

[Create tables] button Creates a database table used with this option. Use this button after creating a new 
database.

[Backup] button Creates database backup files.
This function is specific to the included database only.

[Restore] button Restores the database using a backup file.
This function is specific to the included database only.

[Close] button Closes the dialog box.
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2) Enter the following items in the Choose a Data Source window and click the [Next] button:

Figure 11-11 Choose a Data Source

3) Enter the following items in the Choose a Destination window and click the [Next] button:

Data source: SQL Native Client

Server name: Server name for the included database
Select "Use SQL Server Authentication."

User name: Login ID

Password: Password

Database: TAS7500DB

Destination: SQL Native Client

Server name: Select the "User SQL Server Authentication" migration destination 
server name.

User name: Login ID

Password: Password

Database: TAS7500DB



11–12

11. FDA Compatible Function Option

6/2/14

Figure 11-12Choose a Destination

4) Select "Copy data from one or more tables or views" and click the [Next] button.

5) Select all tables and click the [Edit Mappings] button.
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Figure 11-13Select Source Tables and Views

6) Select the "Delete rows in existing destination tables" checkbox and click the [OK] button.

Figure 11-14Transfer Settings

7) Click the [Finish] button to start the data migration process.

8) Data migration is complete when "Success" is displayed. Click the [OK] button to terminate the
process.
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The migration of database data is now complete.



11–15

11. 4 Navigation Window

6/2/14

11. 4 Navigation Window
This section describes changes made to the existing functions, accompanied with this option.

11. 4. 1 Menu Bar

This section describes the items added for this option.

11. 4. 1. 1 [User]

The [User] menu allows the following selections:

 [User]  [Login]

This command authenticates the user and allows login to the system.

Clicking this command opens the Login dialog box.

 For more information on this dialog box, refer to 11. 11. 1 "Login Dialog Box" on page 11-
25.

 [User]  [Logout]

This command allows logging out from the system.

Logging out is impossible during measurement.

 [User]  [Change Password]

This command changes the user password.
Clicking this command opens the Change Password dialog box.

 For more information on this dialog box, refer to 11. 11. 2 "Change Password Dialog
Box" on page 11-26.

 [User]  [Show Audit Trail]

This command outputs the audit trails on data and users.

Clicking this command opens the Audit Trail dialog box.

 For more information on this dialog box, refer to 11. 15 "Audit Trail" on page 11-37.

 [User]  [User Account Settings]

This command performs user management such as user registration.

Clicking this command opens the User Account Settings dialog box.

 For more information on this dialog box, refer to 11. 11. 3 "User Account Settings Dialog
Box" on page 11-27.
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 [User]  [Database Settings]

This command updates database connection settings and creates, backs up, and restores tables.
 Clicking this command opens the Database Settings dialog box.

 For more information on this dialog box, refer to 11. 3. 4 "Database Settings Dialog Box" on
page 11-9.



11–17

11. 5 Measurement Window in Spectroscopic Unit

6/2/14

11. 5 Measurement Window in Spectroscopic Unit
This section describes changes made to the existing functions, accompanied with this option.

11. 5. 1 Menu Bar

This section describes the items changed for this option.

11. 5. 1. 1 [File]

The following items are added to the [File] menu:

 [File]  [Save to Database]

This command saves sample waveforms to a database.

Clicking this command opens the Save to Database dialog box.

 For more information on this dialog box, refer to 11. 13 "Saving Data" on page 11-34.

The following items are deleted from the [File] menu:

 [File]  [Save Data] 

11. 5. 2 Tool Bar

This section describes the items changed for this option.

11. 5. 3 Condition Setting Area

This section describes the items changed for this option.

Shortcut to [File]  [Save to Database] 
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11. 5. 3. 1 Condition Tab

The following items are changed on the Condition tab:

[Save] button Saves the background waveform to a database.
Clicking this command opens the Save to Database dialog box.

 For more information on this dialog box, refer to 11. 13 "Saving Data" on 
page 11-34.

[Load] button Loads the background waveform from a database.
Clicking this command opens the Data Browser dialog box.

 For more information on this dialog box, refer to 11. 12 "Data Browser" on 
page 11-31.
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11. 6 Measurement Window in Imaging Unit
This section describes changes made to the existing functions, accompanied with this option.

11. 6. 1 Menu Bar

This section describes the items changed for this option.

11. 6. 1. 1 [File]

The following items are added to the [File] menu:

 [File]  [Save to Database]

This command saves obtained data to a database. The sample waveform is saved after point mea-
surement. Imaging data is saved after imaging measurement.

Clicking this command opens the Save to Database dialog box.

 For more information on this dialog box, refer to 11. 13 "Saving Data" on page 11-34.

The following items are deleted from the [File] menu:

 [File]  [Save Data]

11. 6. 2 Tool Bar

This section describes the items changed for this option.

11. 6. 3 Condition Setting Area

This section describes the items changed for this option.

Shortcut to  [File]  [Save to Database]
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11. 6. 3. 1 Condition Tab

The following items are changed on the Condition tab:

[Save] button Saves the background waveform to a database.
Clicking this command opens the Save to Database dialog box.

 For more information on this dialog box, refer to 11. 13 "Saving Data" on page 11-
34.

[Load] button Loads the background waveform from a database.
Clicking this command opens the Data Browser dialog box.

 For more information on this dialog box, refer to 11. 12 "Data Browser" on 
page 11-31.
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11. 7 Analyze Window
This section describes changes made to the existing functions, accompanied with this option.

11. 7. 1 Menu Bar

This section describes the items changed for this option.

11. 7. 1. 1 [File]

The following items are added to the [File] menu:

 [File]  [Show Data Browser]

This command loads data from a database.

Clicking this command opens the Data Browser dialog box.

 For more information on this dialog box, refer to 11. 12 "Data Browser" on page 11-31.

The following items are deleted from the [File] menu:

 [File]  [Load Point Data]

 [File]  [Load Imaging Data]

 [File]  [Load JCAMPDX Data]

 [File]  [Load SPC Data]
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11. 8 Graph Window in Spectroscopic Unit
This section describes changes made to the existing functions, accompanied with this option.

11. 8. 1 Menu Bar

This section describes the items changed for this option.

11. 8. 1. 1 [File]

The following items are added to the [File] menu:

 [File]  [Show Data Browser]

This command loads data from a database.

Clicking this command opens the Data Browser dialog box.

 For more information on this dialog box, refer to 11. 12 "Data Browser" on page 11-31.

 [File]  [Save to Database]

This command saves sample waveforms to a database.

Clicking this command opens the Save to Database dialog box.

 For more information on this dialog box, refer to 11. 13 "Saving Data" on page 11-34.

The following items are deleted from the [File] menu:

 [File]  [Load]
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11. 9 Graph Window in Imaging Unit
This section describes changes made to the existing functions, accompanied with this option.

11. 9. 1 Menu Bar

This section describes the items changed for this option.

11. 9. 1. 1 [File]

The following items are added to the [File] menu:

 [File]  [Save to Database]

This command saves sample waveforms to a database.

Clicking this command opens the Save to Database dialog box.

 For more information on this dialog box, refer to 11. 13 "Saving Data" on page 11-34.
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11.10 Imaging Window
This section describes changes made to the existing functions, accompanied with this option.

11.10. 1 Menu Bar

This section describes the items changed for this option.

11.10. 1. 1 [File]

The following items are added to the [File] menu:

 [File]  [Save to Database]

This command saves sample waveforms to a database.

Clicking this command opens the Save to Database dialog box.

 For more information on this dialog box, refer to 11. 13 "Saving Data" on page 11-34.
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11.11 Option Access Control
Login users registered in the system can use this option.

The system provides three user authorizations, which are distinguished at login.

11.11. 1 Login Dialog Box

The Login dialog box is used to authenticate the user. Successfully authenticated users can use this
option.

This dialog box opens in the following three cases:

1) When [User] [Login] is clicked in the Navigation window.

2) When the mouse and keyboard are not operated for a certain period of time after startup.

3) When authentication is requested for electronic signature.

Authoriza-
tion

Data Electronic signa-
ture

User settings

Administrator Access allowed
Creation and deletion authorizations

Access allowed
Signature authorization

Access allowed
Registration, change, and 
deletion authorizations

Power User Access allowed
Creation and deletion authorizations

Access allowed
Signature authorization

Access prohibited

User Access allowed
Creation and deletion authorizations
However, note that this type of user is 
not allowed to delete signed data.

Access prohibited Access prohibited
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Figure 11-15Login Dialog Box

11.11. 2 Change Password Dialog Box

The Change Password dialog box is used to change the user password.

This dialog box opens if the password expires at system login or if it is forced to change the pass-
word.

Figure 11-16Change Password Dialog Box

User ID Enter the user ID.

Password Enter the password. Entered characters are masked with asterisks (*).

[Anonymous login] button Starts the TAS7x00 without using this option.
When [User] [Login] is clicked in the Navigation window, this button 
is displayed.

[Login] button Closes the dialog box after successful login.

[Cancel] button Closes the dialog box.
When the mouse and keyboard are not operated for a certain period of time 
after startup, this button is disabled.

Old Password Enter the old password. Entered characters are masked with asterisks(*).

New Password Enter the new password. Entered characters are masked with asterisks(*).

Password Verification Enter the new password again. Entered characters are masked with asterisks(*).

[OK] button Updates the password.

[Cancel] button Closes the dialog box.
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11.11. 3 User Account Settings Dialog Box

The User Account Settings dialog box is used to perform user management such as user registration.

Open this dialog box by clicking [User]  [User Account Setting] in the Navigation win-
dow. Only users with Administrator authorization can activate this dialog box.

Tip
 It is recommended that users be registered with a new Administrator authorization when logging into the

system for the first time, which is then deleted.
 

Figure 11-17User Account Settings Dialog Box (User Tab)
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The following describes the User tab in the User Account Settings dialog box:

User list Displays the currently registered user.

Lock Indicates whether the user is locked. 
If this checkbox is selected, that user is not allowed to log into the sys-
tem.

User ID Displays the user ID.

Name Displays the user name.

Role Displays the user authorization.

Password updated Displays the password update date and time.

Failed login attempts Displays the number of password entry attempts.
If the maximum number of password entry attempts is exceeded, that user 
is locked.

[AddNew] button Registers new user data.
Clicking this button opens the Add new user dialog box.
For more information on this dialog box, refer to 11. 11. 4 "Add New 
User Dialog Box" on page 11-30.
Inform the new user of the user ID and old password (password specified 
in user data) required to change the password.

[Update] button Updates user data.
Clicking this button opens the Add new user dialog box.
For more information on this dialog box, refer to 11. 11. 4 "Add New 
User Dialog Box" on page 11-30. 

[Change Password] button Changes the password for the selected user.
Clicking this button opens the Add new user dialog box.
For more information on this dialog box, refer to 11. 11. 4 "Add New 
User Dialog Box" on page 11-30. 

[Remove] button Deletes user data.
Note that the login user cannot be deleted.

[OK] button Closes the dialog box.

[Cancel] button Closes the dialog box.
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Figure 11-18User Account Settings Dialog Box (Common Tab)

The following describes the Common tab in the User Account Settings dialog box:

Tip
 To cancel the user lock, select the relevant user on the User tab, and then click the [Update] button.
 

Minimum length of password Specify the minimum number of characters for the password (0 to 
63).

Maximum number of  failed login 
attempts

Specify the maximum number of password entry attempts (0 to 30). 
If a user consecutively fails to login the specified number of times or 
more, the user is locked out. When 0 is specified, there is not a limit 
on the number of attempts to log in.

Password expires after Specify the password validity period (in days). When 0 is specified, 
the validity period is unlimited (0 to 360).

Lock out account if no activity for Specify the duration (in minutes) following the last mouse or key-
board input before the operation is locked (0 to 180).If 0 is specified, 
it is not locked.

[OK] button Applies the settings and closes the dialog box.

[Cancel] button Closes the dialog box without applying the settings.
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11.11. 4 Add New User Dialog Box

The Add new user dialog box is used for user registration, update, and password change.

Figure 11-19Add New User Dialog Box

User ID Specify the user ID. A duplicate user ID, including deleted user IDs, cannot be 
used.

Password Enter the password. Entered characters are masked with asterisks (*).

Password Verification Enter the password again. Entered characters are masked with asterisks (*).

Role Specify the user authorization.

Name Specify the user name.

Lock account Specify the user lock.

Force to change password Specify whether to forcibly change the password at the next login. This is checked 
when a new user is registered.

[OK] button Applies the settings and closes the dialog box.

[Cancel] button Closes the dialog box without applying the settings.
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11.12 Data Browser
The Data Browser dialog box is used to load spectrum or imaging measurement data from a data-
base.

Figure 11-20Data Browser Dialog Box
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Figure 11-21Search Menu

11.12. 1 Advanced Search

The Advanced Search dialog box is used to specify detailed conditions for database search.

Page specification From the left side, the first page, previous page, current page, next page, and last 
page buttons.

Data list item Specify an item in the data list.

Search string Specify a search string to search items in the data list.

[Search] button Searches the database with the data list item and search string.

[Advanced Search] but-
ton

Clicking this button opens the Advanced Search dialog box.

 For more information on this dialog box, refer to 11. 12. 1 "Advanced 
Search" on page 11-32.

Data list

Name Displays the waveform name.

Type Displays the data type.

Module Displays the unit module during measurement.

Last update Displays the last update date.

Last update by Displays the last person who updated the data.

Authorized by Displays the person who electronically signed the data.

Preview

Image Displays the thumbnail image of the selected data.

Signature Displays the electronic signature for the selected data.

Comment Displays the comment on the selected data.

[Load] button Loads the selected data.

[Sign] button Signs the selected data (with Administrator or Power User authorization).
Clicking this button opens the Sign dialog box.

 For more information on this dialog box, refer to 11. 14 "Electronic 
Signature" on page 11-35.

[Remove] button Deletes the selected data.

[Close] button Closes the dialog box.
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Figure 11-22Advanced Search Dialog Box

Name Specify a waveform name.

Type Specify a data type.

Module Specify the unit module during measurement.

Last update Specify the range of the last update date.

      Start Specify the earliest date to be included in the last update date range.

      End Specify the latest date to be included in the last update date range.

Last update by Specify the last person who updated the data.

Authorized by Specify the person who electronically signed the data.

Comment Specify a comment.

[Search] button Searches using the entered conditions.

[Cancel] button Closes the dialog box.
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11.13 Saving Data
The Save to Database dialog box is used to save spectrum or imaging measurement data to a data-
base.

Figure 11-23Save to Database Dialog Box

Name Specify a waveform name.

[Save] button Saves data to a database.

[Cancel] button Closes the dialog box.
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11.14 Electronic Signature
The Sign dialog box is used to sign data.

Figure 11-24Sign Dialog Box

11.14. 1 Signature Settings Dialog Box

The Signature settings dialog box is used to specify the person who signs the data and the signature
content.

Name Displays the person who signed the data.

Meaning of signature Specify the signature content.

[Signature Setting] 
button

Clicking this button opens the Signature settings dialog box.

 For more information on this dialog box, refer to 11. 14. 1 "Signature Settings 
Dialog Box" on page 11-35.

[OK] button Opens the Login dialog box. Data is signed when authentication is successful.

 For more information on the Login dialog box, refer to 11. 11. 1 "Login Dialog 
Box" on page 11-25.

[Cancel] button Closes the dialog box.
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Figure 11-25Signature Settings Dialog Box

Name Specify the person who signs the data.

Meaning of signature Specify the details of approval and review. Two items can be specified for each.

   Type The kind of signature (Approval/Review)

   Meaning The meaning of signature (Review,Check,Inspection,Approval/etc...)

[OK] button Saves entered data and applies it to the Sign dialog box.

[Cancel] button Closes the dialog box.
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11.15 Audit Trail
The Audit Trail dialog box is used to output the operation history records of data and users.

Figure 11-26Audit Trail Dialog Box
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Figure 11-27Search Menu

11.15. 1 Advanced Search

The Advanced Search dialog box is used to specify detailed conditions for database searches.

Page specification From the left side, the first page, previous page, current page, next page, and last 
page buttons.

Data list item Specify an item in the data list.

Search string Specify a search string to search items in the data list.

[Search] button Searches the database with the data list item and search string.

[Advanced Search] button Clicking this button opens the Advanced Search dialog box.

 For more information on this dialog box, refer to 11. 15. 1 "Advanced 
Search" on page 11-38.

Audit trail list

Date Time Displays the operation date and time.

User Displays the operating user.

Action Displays the details of operation.

[Export] button Outputs search results in CSV format.

[Close] button Closes the dialog box.
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Figure 11-28Advanced Search Dialog Box

Date Time Specify the range of the operation date.

      Start Specify the first operation date.

      End Specify the last operation date.

User Specify the operating user.

Action Specify the details of the operation.

[Search] button Searches using the entered conditions.

[Cancel] button Closes the dialog box.
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12. Software Specifications

This chapter describes the specifications of system software.

12. 1 Configuration of Software
The configuration of this software and product model numbers are as follows:

Basic system software

Option software

12. 1. 1 Media and Documents

When the system or an updated version is delivered, media containing software and manuals is pro-
vided.

12. 1. 2 Installation

The first installation of software is conducted by Advantest at the time of shipment of the system.

Updated versions need to be installed by the user.

TAS7500 System Software PYSI75-00M

TAS7400 System Software PYSI74-00M

TAS7500 Offline Software PYSA75-00M

TAS7500 Coating Quality Analysis Application License PYSI75-04M

TAS7500 Offline Coating Quality Analysis Application License PYSA75-04M

TAS7500 Quantitative Analysis Application Software PYSI75-02M

TAS7500 Offline Quantitative Analysis Application Software PYSA75-02M

TAS7500 Polarization Analysis Application License PYSI75-05M

TAS7500 Offline Polarization Analysis Application License PYSA75-05M

TAS7500 FDA Compatible Function License PYSI75-06M

TAS7500 Offline FDA Compatible Function License PYSA75-06M

TAS7400 Offline Software PYSA74-00M

TAS7400 Polarization Analysis Application License PYSI74-05M

TAS7400 Offline Polarization Analysis Application License PYSA74-05M

TAS7400 FDA Compatible Function License PYSI74-06M

TAS7400 Offline FDA Compatible Function License PYSA74-06M
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However, if it is desired that an updated version be installed by an Advantest engineer, contact our
sales representative.

12. 1. 3 Requirements

The hardware and software configurations required for this software and system expansion are
described in the following sections.

12. 1. 3. 1 Required Hardware Configuration

One PC is required when using this software offline.

The specifications required for hardware resources are described in the following table:

Important
 

• CPUs other than Intel's may provide insufficient performance.

• Video cards other than nVIDIA's may provide insufficient performance.
 

12. 1. 3. 2 Required Software Configuration

All software needed when this system is used online is included with the product.

The software needed when this system is used offline is as follows:

Important
 

• Windows 7 is used in the Japanese or English language environment.
 

Hardware resource Minimum value Recommended value

CPU
Intel Core 2 Duo CPU
E8200 @ 2.66 GHz or equivalent

Intel Core i7 CPU
860 @ 2.80 GHz

Memory capacity 2 GB 4 GB

Free disk space 3 GB Depends on the number of saved data files

Video card nVIDIA GeForce GTS 240 or equivalent nVIDIA GeForce GTS 240 or equivalent

Software type Software name

Basic OS Windows 7 Professional Service Pack 1 (64 bit)
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12. 1. 3. 3 System Expansion

According to future enhancements of software and hardware, additional equipment and software
may be required to operate system software.

12. 1. 4 Software Support

Delivered software is supported for one year without charge. The content of software support
depends on Advantest software support criteria. Software support after one year has elapsed is
charged to the customer.

To use the latest improved software, a software support contract is highly recommended after one
year.

12. 1. 5 Orders

When ordering this software, specify the name and service location of the software, and also the
TAS7x00 Series Terahertz Spectroscopy & Imaging System model in which the software is to be
installed.





F–1

6/2/14

List of Figures

Figure 2-1 TAS7x00 Icon ................................................................................. 2-1

Figure 2-2 Navigation Window ........................................................................ 2-1

Figure 3-1 Navigation Window ........................................................................ 3-1

Figure 4-1 Spectroscopy Button ...................................................................... 4-1

Figure 4-2 Spectroscopic Measurement Window ............................................ 4-2

Figure 4-3 Setting Mirror .................................................................................. 4-2

Figure 4-4 General Tab in Condition Setting Area .......................................... 4-3

Figure 4-5 Condition Tab in Condition Setting Area ........................................ 4-4

Figure 4-6 Background Measurement ............................................................. 4-5

Figure 4-7 Setting Sample ............................................................................... 4-5

Figure 4-8 Sample Measurement .................................................................... 4-6

Figure 4-9 Analysis Button .............................................................................. 4-7

Figure 4-10 Analyze Window ............................................................................. 4-7

Figure 4-11 Graph Window ............................................................................... 4-8

Figure 4-12 Graph Window Displaying Reflectance .......................................... 4-8

Figure 4-13 Smoothing Dialog Box .................................................................... 4-9

Figure 4-14 Graph Window after Smoothing ..................................................... 4-10

Figure 4-15 Peak Detection Dialog Box ............................................................ 4-11

Figure 4-16 Displaying Labels (Positions on Horizontal Axis) ........................... 4-11

Figure 4-17 Two Waveforms ............................................................................. 4-12

Figure 4-18 Graph Window where Two Waveforms Overlap ............................ 4-12

Figure 4-19 Background Measurement ............................................................. 4-14

Figure 4-20 Sample Measurement .................................................................... 4-15

Figure 4-21 Transferred Polarization Analysis Data .......................................... 4-15

Figure 4-22 Displaying the Polarization Analysis Data along Various Axes ...... 4-17

Figure 4-23 Spectroscopic Measurement Window ............................................ 4-19

Figure 4-24 Programmable Measurement Dialog Box ...................................... 4-28

Figure 4-25 Naming Rules Dialog Box .............................................................. 4-29

Figure 4-26 Parameter Settings Dialog Box ...................................................... 4-30

Figure 4-27 Visualization Dialog Box ................................................................. 4-32

Figure 4-28 Environment Dialog Box ................................................................. 4-35

Figure 4-29 Print Report Dialog Box .................................................................. 4-38

Figure 4-30 Preview .......................................................................................... 4-39

Figure 4-31 Report Settings Dialog Box ............................................................ 4-40

Figure 4-32 Graph Window ............................................................................... 4-41



F–2

6/2/14

Figure 4-33 Properties Dialog Box .................................................................... 4-43

Figure 4-34 Analyze Window ............................................................................. 4-47

Figure 4-35 Graph Window ............................................................................... 4-50

Figure 4-36 Scaling and Offset Dialog Box ....................................................... 4-55

Figure 4-37 Baseline Correction Dialog Box ..................................................... 4-56

Figure 4-38 Deconvolution Dialog Box .............................................................. 4-57

Figure 4-39 Derivative Dialog Box ..................................................................... 4-58

Figure 4-40 FFT Filter Dialog Box ..................................................................... 4-60

Figure 4-41 Interpolation Dialog Box  ................................................................ 4-61

Figure 4-42 Normalize Dialog Box ..................................................................... 4-63

Figure 4-43 Peak Removal Dialog Box ............................................................. 4-64

Figure 4-44 Smoothing Dialog Box  ................................................................... 4-65

Figure 4-45 Peak Detection Dialog Box ............................................................ 4-67

Figure 4-46 Peak Height Dialog Box ................................................................. 4-68

Figure 4-47 Peak Area Dialog Box .................................................................... 4-69

Figure 4-48 Peak Half Bandwidth Dialog Box ................................................... 4-70

Figure 4-49 Data Select Dialog Box .................................................................. 4-71

Figure 4-50 Four Arithmetic Operations with Two Spectra Dialog Box ............. 4-71

Figure 4-51 Save All Data on the Graph Window Dialog Box ........................... 4-78

Figure 4-52 Scale Settings Dialog Box .............................................................. 4-79

Figure 4-53 Background Settings Dialog Box .................................................... 4-79

Figure 5-1 Imaging Button ............................................................................... 5-3

Figure 5-2 Measurement Window ................................................................... 5-3

Figure 5-3 Simple Tablet Shape Definition Dialog Box ................................... 5-4

Figure 5-4 Cassette Select Dialog Box ............................................................ 5-4

Figure 5-5 Setting Shape Information to Cassette .......................................... 5-5

Figure 5-6 General Tab in Condition Setting Area .......................................... 5-6

Figure 5-7 Condition Tab in Condition Setting Area ........................................ 5-7

Figure 5-8 Calculate Tab in Condition Setting Area ........................................ 5-8

Figure 5-9 Shape Measurement Tab in Condition Setting Area ...................... 5-9

Figure 5-10 Point Measurement ........................................................................ 5-11

Figure 5-11 Time of Flight Analysis Dialog Box ................................................. 5-12

Figure 5-12 Specifying Analysis Definition File ................................................. 5-13

Figure 5-13 Specifying Measurement Target Tablet ......................................... 5-13

Figure 5-14 Specifying Measurement Resolution and Measuring Plane ........... 5-13

Figure 5-15 Imaging Measurement ................................................................... 5-14

Figure 5-16 Analysis Button .............................................................................. 5-15

Figure 5-17 Analysis Window ............................................................................ 5-15



F–3

6/2/14

Figure 5-18 Imaging Window ............................................................................. 5-16

Figure 5-19 Displaying Imaging Projection ........................................................ 5-17

Figure 5-20 LinePlot Window ............................................................................ 5-18

Figure 5-21 LineTomography Window .............................................................. 5-19

Figure 5-22 Measurement Window ................................................................... 5-20

Figure 5-23 Tablet Settings for Measurement Window ..................................... 5-30

Figure 5-24 Tablet Selection Area ..................................................................... 5-31

Figure 5-25 Simple Tablet Shape Definition Dialog Box ................................... 5-35

Figure 5-26 Area Decomposition Settings Dialog Box ...................................... 5-38

Figure 5-27 Background Position Settings Dialog Box ...................................... 5-40

Figure 5-28 Cassette Select Dialog Box ............................................................ 5-41

Figure 5-29 Singular measurement point setting Dialog Box ............................ 5-42

Figure 5-30 Graph Window ............................................................................... 5-43

Figure 5-31 Imaging Window ............................................................................. 5-45

Figure 5-32 Scale Settings Dialog Box .............................................................. 5-48

Figure 5-33 Analysis Window ............................................................................ 5-49

Figure 5-34 Graph Window ............................................................................... 5-52

Figure 5-35 Time of Flight Analysis Dialog Box ................................................. 5-56

Figure 5-36 Imaging Window ............................................................................. 5-58

Figure 5-37 Background Settings Dialog Box (Imaging Data for R3.00 or Earlier) 5-62

Figure 5-38 Background Settings Dialog Box (Imaging Data for R3.01 or Later) 5-63

Figure 5-39 Merge Imaging Data Dialog Box .................................................... 5-63

Figure 5-40 LinePlot Window ............................................................................ 5-66

Figure 5-41 LineTomography Window .............................................................. 5-69

Figure 5-42 Scale Settings Dialog Box .............................................................. 5-72

Figure 5-43 Histogram Window ......................................................................... 5-73

Figure 5-44 Gradation View Window ................................................................. 5-75

Figure 6-1 PQ/OQ Button ................................................................................ 6-1

Figure 6-2 PQ/OQ Window .............................................................................. 6-2

Figure 6-3 TH-710036 Standard Sample ........................................................ 6-3

Figure 6-4 How to Set Standard Sample ......................................................... 6-4

Figure 6-5 How to Set Standard Sample ......................................................... 6-5

Figure 6-6 PQ/OQ Window .............................................................................. 6-6

Figure 7-1 Tablet Area Division and Multipoint Background Data Settings ..... 7-8

Figure 7-2 Image of Oblong Tablet Area Division ........................................... 7-9

Figure 7-3 Image of Multipoint Background Data Settings for Oblong Tablets 7-10

Figure 7-4 Position in Cassette for Reference for which Multipoint Background 

Data Settings Are Valid .................................................................. 7-10



F–4

6/2/14

Figure 8-1 Example Password ........................................................................ 8-1

Figure 8-2 Sample Password Sheet (CpuFixed) ............................................. 8-4

Figure 8-3 Example of License Server ............................................................ 8-4

Figure 11-1 Connecting to Server ..................................................................... 11-4

Figure 11-2 Object Explorer .............................................................................. 11-4

Figure 11-3 New Database ................................................................................ 11-5

Figure 11-4 System DSN ................................................................................... 11-6

Figure 11-5 Creating New Data Source ............................................................ 11-6

Figure 11-6 Entering Server Name .................................................................... 11-7

Figure 11-7 Entering Login ID ........................................................................... 11-7

Figure 11-8 Entering Default Database ............................................................. 11-8

Figure 11-9 Database Connection Settings ....................................................... 11-9

Figure 11-10 Database Settings Dialog Box ....................................................... 11-10

Figure 11-11 Choose a Data Source ................................................................... 11-11

Figure 11-12 Choose a Destination ..................................................................... 11-12

Figure 11-13 Select Source Tables and Views ................................................... 11-13

Figure 11-14 Transfer Settings ............................................................................ 11-13

Figure 11-15 Login Dialog Box ............................................................................ 11-26

Figure 11-16 Change Password Dialog Box ....................................................... 11-26

Figure 11-17 User Account Settings Dialog Box (User Tab) ............................... 11-27

Figure 11-18 User Account Settings Dialog Box (Common Tab) ........................ 11-29

Figure 11-19 Add New User Dialog Box .............................................................. 11-30

Figure 11-20 Data Browser Dialog Box ............................................................... 11-31

Figure 11-21 Search Menu .................................................................................. 11-32

Figure 11-22 Advanced Search Dialog Box ........................................................ 11-33

Figure 11-23 Save to Database Dialog Box ........................................................ 11-34

Figure 11-24 Sign Dialog Box .............................................................................. 11-35

Figure 11-25 Signature Settings Dialog Box ....................................................... 11-36

Figure 11-26 Audit Trail Dialog Box ..................................................................... 11-37

Figure 11-27 Search Menu .................................................................................. 11-38

Figure 11-28 Advanced Search Dialog Box ........................................................ 11-39


	Legal Notices
	Revision History
	Table of Contents �
	Preface
	Purpose of This Manual
	Related Manuals

	1. Overview
	2. System Start Up and Shut Down
	2. 1 System Start Up
	2. 2 System Shut Down

	3. Navigation Window
	3. 1 Window Layout
	3. 2 Menu Bar
	3. 3 Tool Bar

	4. Spectroscopic Unit
	4. 1 Operating Procedure
	4. 1. 1 Basic Measurement Operations
	4. 1. 2 Basic Analysis Operations
	4. 1. 3 Polarization Measurement and Analysis Operations (Polarization Analysis Option)

	4. 2 Spectroscopic Measurement Window
	4. 2. 1 Window Layout
	4. 2. 2 Menu Bar
	4. 2. 2. 1 [File]
	4. 2. 2. 2 [Measurement]
	4. 2. 2. 3 [Options]
	4. 2. 2. 4 [Window]

	4. 2. 3 Tool Bar
	4. 2. 4 Condition Setting Area
	4. 2. 4. 1 General Tab
	4. 2. 4. 2 Condition Tab

	4. 2. 5 Dialog Boxes
	4. 2. 5. 1 Programmable Measurement Dialog Box
	4. 2. 5. 2 Naming Rules Dialog Box
	4. 2. 5. 3 Parameter Settings Dialog Box
	4. 2. 5. 4 Visualization Dialog Box
	4. 2. 5. 5 Environment Dialog Box
	4. 2. 5. 6 Print Report Dialog Box
	4. 2. 5. 7 Report Settings Dialog Box


	4. 3 Graph Window in Spectroscopic Measurement Window
	4. 3. 1 Window Layout
	4. 3. 2 Tool Bar
	4. 3. 3 Pop-up Menu
	4. 3. 4 Dialog Boxes
	4. 3. 4. 1 Properties Dialog Box


	4. 4 Analyze Window
	4. 4. 1 Window Layout
	4. 4. 2 Menu Bar
	4. 4. 2. 1 [File]
	4. 4. 2. 2 [Options]
	4. 4. 2. 3 [Window]


	4. 5 Graph Window in Analyze Window
	4. 5. 1 Window Layout
	4. 5. 2 Menu Bar
	4. 5. 2. 1 [File]
	4. 5. 2. 2 [Horizontal Axis]
	4. 5. 2. 3 [Vertical Axis]
	4. 5. 2. 4 [Calculation]
	4. 5. 2. 5 [Analysis]
	4. 5. 2. 6 [Polarization] (Polarization Analysis Option)

	4. 5. 3 Tool Bar
	4. 5. 4 Pop-up Menu
	4. 5. 5 Dialog Boxes
	4. 5. 5. 1 Save All Data on the Graph Window Dialog Box
	4. 5. 5. 2 Scale Settings Dialog Box
	4. 5. 5. 3 Background Settings Dialog Box



	5. Imaging Unit
	5. 1 Operating Procedures
	5. 1. 1 Basic Operations for Measurement
	5. 1. 2 Basic Operations for Analysis

	5. 2 Measurement Window
	5. 2. 1 Window Layout
	5. 2. 2 Menu Bar
	5. 2. 2. 1 [File]
	5. 2. 2. 2 [Measurement]
	5. 2. 2. 3 [Options]
	5. 2. 2. 4 [Window]

	5. 2. 3 Tool Bar
	5. 2. 4 Condition Setting Area
	5. 2. 4. 1 General Tab
	5. 2. 4. 2 Condition Tab
	5. 2. 4. 3 Calculate Tab
	5. 2. 4. 4 Shape Measurement Tab

	5. 2. 5 Tablet Settings for Measurement Window
	5. 2. 6 Dialog Box
	5. 2. 6. 1 Simple Tablet Shape Definition Dialog Box
	5. 2. 6. 2 Area Decomposition Settings Dialog Box
	5. 2. 6. 3 Background Position Settings Dialog Box
	5. 2. 6. 4 Cassette Select Dialog Box
	5. 2. 6. 5 Singular measurement point setting Dialog Box


	5. 3 Graph Window in Measurement Window
	5. 3. 1 Window Layout
	5. 3. 2 Tool Bar
	5. 3. 3 Pop-up Menu

	5. 4 Imaging Window in Measurement Window
	5. 4. 1 Window Layout
	5. 4. 2 Tool Bar
	5. 4. 3 Pop-up Menu
	5. 4. 3. 1 Properties Dialog Box

	5. 4. 4 Dialog Box
	5. 4. 4. 1 Scale Settings Dialog Box


	5. 5 Analysis Window
	5. 5. 1 Window Layout
	5. 5. 2 Menu Bar
	5. 5. 2. 1 [File]
	5. 5. 2. 2 [Options]
	5. 5. 2. 3 [Window]


	5. 6 Graph Window in Analysis Window
	5. 6. 1 Window Layout
	5. 6. 2 Menu Bar
	5. 6. 2. 1 [File]
	5. 6. 2. 2 [Horizontal Axis]
	5. 6. 2. 3 [Vertical Axis]
	5. 6. 2. 4 [Analysis]

	5. 6. 3 Tool Bar
	5. 6. 4 Pop-up Menu
	5. 6. 5 Dialog Box
	5. 6. 5. 1 Time of Flight Analysis Dialog Box


	5. 7 Imaging Window in Analysis Window
	5. 7. 1 Window Layout
	5. 7. 2 Menu Bar
	5. 7. 2. 1 [File]
	5. 7. 2. 2 [Analysis]

	5. 7. 3 Pop-up Menu
	5. 7. 4 Dialog Box
	5. 7. 4. 1 Background Settings Dialog Box
	5. 7. 4. 2 Merge Imaging Data Dialog Box

	5. 7. 5 Tool Bar
	5. 7. 6 Projection Drawing

	5. 8 LinePlot Window in Analysis Window
	5. 8. 1 Window Layout
	5. 8. 2 Menu Bar
	5. 8. 2. 1 [File]

	5. 8. 3 Tool Bar
	5. 8. 4 Pop-up Menu

	5. 9 LineTomography Window in Analysis Window
	5. 9. 1 Window Layout
	5. 9. 2 Menu Bar
	5. 9. 2. 1 [File]
	5. 9. 2. 2 [View]

	5. 9. 3 Tool Bar
	5. 9. 4 Pop-up Menu
	5. 9. 5 Dialog Box
	5. 9. 5. 1 Scale Settings Dialog Box


	5. 10 Histogram Window in Analysis Window
	5. 10. 1 Window Layout
	5. 10. 2 Menu Bar
	5. 10. 2. 1 [File]

	5. 10. 3 Tool Bar

	5. 11 Gradation View Window in Analyze Window
	5. 11. 1 Window Layout
	5. 11. 2 Menu Bar
	5. 11. 2. 1 [File]

	5. 11. 3 Tool Bar


	6. PQ/OQ Test
	6. 1 Operating Procedures
	6. 1. 1 Starting PQ/OQ Window
	6. 1. 2 Basic Operations Using Spectroscopic Unit
	6. 1. 3 Basic Operations Using Imaging Unit
	6. 1. 3. 1 PQ/OQ Test
	6. 1. 3. 2 Stage Positioning Accuracy Test


	6. 2 PQ/OQ Window
	6. 2. 1 Window Layout
	6. 2. 2 Menu Bar
	6. 2. 2. 1 [File]
	6. 2. 2. 2 [PQ/OQ]
	6. 2. 2. 3 [Options]

	6. 2. 3 Tool Bar
	6. 2. 4 Condition Setting Area
	6. 2. 5 Result Display Area

	6. 3 Graph Window in PQ/OQ Window

	7. Glossary
	7. 1 Calculation List (File)
	7. 2 Phase Unwrap Processing
	7. 3 ATR Correction
	7. 4 Fourier Self Deconvolution (FSD Method)
	7. 5 Data Interpolation
	7. 5. 1 Lagrange Interpolation
	7. 5. 2 Cubic Spline Interpolation

	7. 6 Smoothing
	7. 6. 1 Simple Moving Average Method
	7. 6. 2 Savitzky-Golay Method
	7. 6. 3 Adaptive Smoothing Method
	7. 6. 4 Binomial Method

	7. 7 Analysis Definition File
	7. 8 Tablet Area Division and Multipoint Background Data Settings
	7. 8. 1 Tablet Area Division
	7. 8. 2 Multipoint Background Data Settings

	7. 9 Tablet Shape Measurement

	8. Using System Software Offline
	8. 1 Installing Software
	8. 2 Uninstalling Software
	8. 3 Registering License

	9. Coating Quality Analysis Option
	9. 1 Functions of Option
	9. 2 Registering License

	10. Polarization Analysis Option
	10. 1 Functions of Option
	10. 2 Registering License

	11. FDA Compatible Function Option
	11. 1 Functions of Option
	11. 2 Registering License
	11. 3 Setting and Managing Database
	11. 3. 1 Creating Database
	11. 3. 2 Registering ODBC Connection Settings
	11. 3. 3 Initial Settings
	11. 3. 4 Database Settings Dialog Box
	11. 3. 5 Migrating Database Data

	11. 4 Navigation Window
	11. 4. 1 Menu Bar
	11. 4. 1. 1 [User]


	11. 5 Measurement Window in Spectroscopic Unit
	11. 5. 1 Menu Bar
	11. 5. 1. 1 [File]

	11. 5. 2 Tool Bar
	11. 5. 3 Condition Setting Area
	11. 5. 3. 1 Condition Tab


	11. 6 Measurement Window in Imaging Unit
	11. 6. 1 Menu Bar
	11. 6. 1. 1 [File]

	11. 6. 2 Tool Bar
	11. 6. 3 Condition Setting Area
	11. 6. 3. 1 Condition Tab


	11. 7 Analyze Window
	11. 7. 1 Menu Bar
	11. 7. 1. 1 [File]


	11. 8 Graph Window in Spectroscopic Unit
	11. 8. 1 Menu Bar
	11. 8. 1. 1 [File]


	11. 9 Graph Window in Imaging Unit
	11. 9. 1 Menu Bar
	11. 9. 1. 1 [File]


	11. 10 Imaging Window
	11. 10. 1 Menu Bar
	11. 10. 1. 1 [File]


	11. 11 Option Access Control
	11. 11. 1 Login Dialog Box
	11. 11. 2 Change Password Dialog Box
	11. 11. 3 User Account Settings Dialog Box
	11. 11. 4 Add New User Dialog Box

	11. 12 Data Browser
	11. 12. 1 Advanced Search

	11. 13 Saving Data
	11. 14 Electronic Signature
	11. 14. 1 Signature Settings Dialog Box

	11. 15 Audit Trail
	11. 15. 1 Advanced Search


	12. Software Specifications
	12. 1 Configuration of Software
	12. 1. 1 Media and Documents
	12. 1. 2 Installation
	12. 1. 3 Requirements
	12. 1. 3. 1 Required Hardware Configuration
	12. 1. 3. 2 Required Software Configuration
	12. 1. 3. 3 System Expansion

	12. 1. 4 Software Support
	12. 1. 5 Orders


	List of Figures �

